Table of Contents

INTRODUCING OFFICE ................................................................. 1

Office User’s Guide ................................................................. 2

Module One – System Requirements ................................................. 4
  Minimum Requirements .......................................................... 4
  Browser Requirements ............................................................ 5

Module Two – Getting Started .......................................................... 6
  Log In .................................................................................. 6
    I Forgot My Password ......................................................... 6
  Home Page ........................................................................... 9
  Main Menu .......................................................................... 10
  Change or Reset Password ......................................................... 10
    Change Your Password ......................................................... 11
  Session Time-out .................................................................. 12
  User Account Information .......................................................... 12
    Security Questions .............................................................. 13
  Admin User Request Service ....................................................... 14
  User Management ................................................................. Error! Bookmark not defined.
    Location List Management ...................................................... 17
      Add a Location .................................................................. 17
      Edit a Location .................................................................. 19
    User List Management .......................................................... 21
      Find an Existing User .......................................................... 21
      Add a New User ................................................................. 22
      Edit User Information .......................................................... 24
      Reset a Password ............................................................... 26
      Activate or Deactivate a User .................................................. 28
  Manage Favorite Lists .............................................................. 30
    Group Favorites ................................................................. 30
    Manage Provider Favorites ...................................................... 30
    Update Provider ID Drop-down Lists ........................................... 30
    Edit a Provider Record .......................................................... 31
    Add a New Provider ............................................................. 32
    Online Payer Enrollment .......................................................... 33
    Required Fields for Payer Enrollment ......................................... 35
    Medical Codes Favorites Lists .................................................... 36
    Add Procedure, Diagnosis and CDT4 Codes .................................. 36
    Add Service Type and Place of Service Codes .................................. 37
Customize Batch Services
Batch Mode Settings
Group Settings
Select Columns
Select # of Batch Transactions per Page
Resubmit a Transaction
View Batch Responses
Search for Batches
Search within a Batch
Move or Copy Inquiries
Delete Inquiries
Module Nine – Batch Import & Export
Import a File
Batch Export
Export Inquiries
X12 Full Response
Summary Response
Module Ten – Find Providers
Find a Provider
Duplicate Provider Records
Module Eleven – Payment
Payment Manager
Charge Credit Card
Manually Submit a Credit Card Payment
Credit Card Swipe
Setup and System Requirements
Use Credit Card Swipe
Credit Card Report
Setup & Help

Error! Bookmark not defined.
Introducing Office

Office is a web-based solution that provides multi-transaction capabilities including eligibility, referrals, authorizations and claims. It supports communication with payers in a customized fashion that optimizes the user experience within the unique context of each payer. It features industry-leading advanced functionality related to eligibility and claim status batch management, intra-transaction workflow, secure email and VAR support.

Office helps streamline and automate key business functions, including:

- Eligibility Verification
- Claims Status Verification
- Referral Submission & Referral Inquiry
- E-mail Reports

Office is ideal for both front and back office users in all types of provider settings, such as:

- Hospital Business Offices, Admitting & Emergency Departments
- Physician Practices
- Reference Labs
- Medical Billing Services

Connectivity

Office enables connectivity between: 300,000 physicians, 4,600 hospitals, 600 vendor partners, and more than 1,000 commercial and government payers.
Office User’s Guide

The following material is included in this guide:

Module One - System Requirements
- Minimum Requirements
- Browser Requirements

Module Two - Getting Started
- Log In
- Home Page
- Main Menu
- Change or Reset Passwords
- Session Time-out
- User Account Information
- Admin User Request Service
- User Management
- Manage Favorite Lists

Module Three - Edit Payer List
- Edit the Payer List
- Request Page Features

Module Four - Check Eligibility
- Submit an Eligibility Request
- Card Swipe
- Patient Responsibility Estimator (PRE)
- Contract Rate Utility

Module Five - Check Claims
- Check a Claim Status
- Card Swipe
- Claim Status Information
- Claim Financial Inquiry

Module Six - HCS Review Request
- Submit a New Referral
- Card Swipe

Module Seven - HCS Review Inquiry
- Check a Referral
Office - Real Time Transactions

- Card Swipe
- Referral Status Information

Module Eight - Batch Manager
- Create a Batch
- Add Transactions to a Batch
- Batch Manager Tip 1
- Submit a Batch
- Batch Manager Tip 2
- Responses
- Sort Transactions
- Re-submit a Batch
- Customize Batch Services
- View Batch Responses
- Search for Batches
- Search within a Batch
- Move or Copy Inquiries
- Delete Inquiries

Module Nine - Batch Import & Export
- Import a File
- Batch Export

Module Ten - Find Providers
- Find a Provider
- Duplicate Provider Records

Module Eleven - Payment
- Payment Manager
- Charge Credit Card
- Manually Submit a Credit Card Payment
- Credit Card Swipe
- Credit Card Report
- Setup & Help

NOTE: All the data contained in this guide is for demonstration purposes only and does not contain any real patient/provider information.
Module One – System Requirements

Objectives
In this section you will learn about the minimum system requirements and browser requirements for Office.

Minimum Requirements
Before using Office, it is important to insure all user workstations meet the basic system requirements. This information is available by clicking the System Requirements link on the Office login page.

System Requirements

<table>
<thead>
<tr>
<th></th>
<th>Minimum</th>
<th>Preferred</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Personal Computer</strong></td>
<td>Pentium Class PC</td>
<td>Pentium Class PC</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>32MB RAM</td>
<td>64MB RAM</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>Color Monitor 800 x 600</td>
<td>Color Monitor 1024 x 768</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows (95, 98, NT, 2000 or XP)</td>
<td>Windows (NT, 2000 or XP)</td>
</tr>
<tr>
<td><strong>Internet Browser</strong></td>
<td>Internet Explorer v6.0 or v7.0</td>
<td>Internet Explorer v6.0 or v7.0</td>
</tr>
<tr>
<td></td>
<td>Firefox</td>
<td></td>
</tr>
<tr>
<td><strong>Internet Connection</strong></td>
<td>56.6 kbps modem, DSL, cable modem, ISDN, T-1 OR other high-speed connection</td>
<td>DSL, cable modem, ISDN, T-1 OR other high-speed connection</td>
</tr>
</tbody>
</table>

Download Internet Explorer
Browser Requirements

Office supports Microsoft Internet Explorer, version 6.0 or greater and Firefox. To insure the security of each transaction, all sites must have 128-bit encryption.

The Office ERS (Email and Reports System) supports cross browser capabilities for Internet Explorer 6.0 or greater for Windows 98 or greater; and Firefox 2.0 or greater for Windows 98 or greater.

To verify the version number of a user’s browser

1. Select Help from the Internet Explorer main menu and then click on the last menu option “About Internet Explorer.” This brings up a new box that displays the version number of Internet Explorer.

2. If the version number is below the required Browser version, click on the update feature within that box to update the browser.

Non-Supported Browsers

Netscape is not supported.

AOL users must login as they normally do, but then minimize AOL and launch Internet Explorer.
Module Two – Getting Started

Objectives
In this section you will learn how to do the following:

- Log in
- Navigate the home page and main menu
- Change or reset passwords
- Edit user account information
- Request an administrative user account
- Manage Favorite Lists

Log In
To log into Office:

1. Type in the following URL in the address line of your browser:
   https://office.emdeon.com/
   The Office login page appears.

   ![Login Screen]
   Enter your User ID and Password.

2. Click on the Log In button. After a few seconds, the home page appears, as shown on page 9.

I Forgot My Password
This link allows you to have your password reset in case you forget it or are locked out of the system. Clicking the link will display this screen:
Answer the two security questions, enter your Tax ID and Zip Code in the appropriate fields, and click Submit.

Depending on the information you already have on file, one of the following scenarios will occur:

**Scenario # 1**
If the following is true:

- you have previously saved security questions on the User Account Information page,
- you enter the correct information in all four fields, and
- you have a valid email address on file,

an email will be sent to the email address on file which contains a message similar to the following:

```
Subject: Your administrators can help!

Dear User,

We are sending this message to the email address on file to notify you that someone is attempting to access your account. If you are not the person reporting login problems, please contact your administrator or [Company] immediately.

If you are able to correctly answer the security message, you will receive a second email from us containing the link you need to use to reset your password. If you do not receive that message, please contact your administrators, or our help desk, for
```
alternate assistance.

Please do not reply to this message as it is system generated.

Regards,
Customer Support

Scenario # 2
If the following is true:

- you have previously saved security questions on the User Account Information page,
- you enter the correct information in all four fields, and
- you do not have a valid email address on file,

a list of administrators and their phone numbers will be displayed, as well as this message:

Because we do not have your email address on file we cannot complete the automated reset of your account. Please contact your administrator for further assistance. If you have no administrator available to help, please email your password reset request to pwreset@emdeon.com. Please include as much information about who you are as you can. We recommend including your User ID and Tax ID. We will contact you to reset your password.

Scenario # 3
If the following is true:

- the User ID is invalid,
- the information you provided in any of the four fields is incorrect, or
- you have not previously set up security questions,

the following message will be displayed:

One or more values did not match the recorded ones in your account. Please revise your data and resubmit.

For additional help, please contact your site administrator.
Home Page

The home page is the first screen a user sees after logging into Office.

The Logout link is on the top right corner of the navigation bar beside the Help link. You should log out every time you leave your workstation for an extended period of time, in order to insure the confidentiality of patient data.

A down arrow on a menu button indicates there is a sub-menu below it.

Depending on which services you are set up to use, the contents of the home page may vary. For this reason, some of the features that appear in the screen above may not be visible to all users. The home page features the following sections:

The home page features the following sections:

Message Center
- Mail messages - provides access to email messages. A count of unread messages in all folders appears next to the link.
- Claims batch - indicates the number of claims batches that need supplementing. When the hyperlinked text “claims batch” is clicked, the list of pending batches is displayed so they can be worked. The claims batch counter only displays if you submit claims and if you’re configured for access to the secondary claims service.
- Customer Communications - displays open customer service alerts for all payers with whom the user is enrolled for claim submission. Alerts related to payer outages in eligibility and claim status processing are also available for many but not all insurance companies.

Flash Messages - contains important updates about upcoming enhancements or
changes. New payer announcements, along with workshops and seminar invitations, can also be found here.

**Promotions** - features links to special promotional opportunities.

**Customer Support** - provides access to online help, video tutorials and web-based training, customer support and other key information.

**Help** - provides information about the screen you are viewing.

**Main Menu**

Below are the main menu options and their functions:

- **Home** displays the home page.
- **Eligibility** allows users to obtain patient benefit and co-pay information in real time.
- **Service Review** allows users to create and submit a referral authorization or pre-certification to payers electronically and to check the status of any referral, authorization or pre-certification sent to a payer.
- **Find Providers** allows users to find all providers associated with a specific payer. This is a useful feature for offices who want to refer patients to a specialist within their insurance plan.
- **Claims** allows users who are subscribed to the claim submission service to create or import claims. Users may also monitor their claims for current reimbursement or denial status using Check Claims and Emdeon Vision. Links to claims reference materials such as enrollment tools, user’s guides and tutorials are also featured.
- **Payment** provides access to several financial services including credit card payments and Payment Manager. The credit card service allows you to accept credit card charges from your patients. Payment Manager allows you to view and manage your EOBs and remits.
- **Setup** has links to various services that allow users to manage their favorite lists, update user account information, change passwords and obtain payer enrollment data. In addition, administrative users have access to the Manage Users service, which allows them to add, change, and delete users from their practice.

**Help** ([?]) is context sensitive. The information displayed depends on the screen that is currently active.

**Batch Manager** ([ ]] allows users to create, manage and submit batches for eligibility, claim status, referral, authorization and pre-certification transactions. To access claims batches, claims submitters should select Vision from the Claims tab. Claims direct data entry customers can also use the List option in the Claims section.

**Logout** ([ ] ) logs the user out of the session.

**Change or Reset Passwords**

The Change Password page displays when a user’s password expires, when a user logs
in for the first time or when a password is reset by an Admin user. This page can also be accessed by selecting Setup > My Account.

Passwords must be changed every 90 days. The system alerts users several days before their password is about to expire. If they allow their password to expire, they will need to contact their site administrator to reset it.

Avoid sharing your log in information with any unauthorized persons. Allowing anyone to use your access information compromises the security of confidential data about your office and your patients.

Users can change their password at any time by selecting Setup > My Account and clicking the Change Password link, as long as they don’t reset their password more than 3 times in a given day.

Note: If users reset their password more than 3 times in a given day, the fourth time they attempt to change their password they will see the message: “Excessive password resets detected. Please contact your site administrator or the Help Desk for assistance.”

If you forget your password, you may contact our toll-free customer support number, 1-877-469-3263. Telephone support is staffed by Help Desk Analysts at the Customer Service Centers on standard business days (normally Monday through Friday) from 8 AM to 8 PM Eastern Time. After a Customer Service Representative resets your password, you may log into Office and change your password.

**Change Your Password**

Follow these steps to change your password:

1. Select Setup > My Account, and click the Change Password link. The Change Password form displays.
2. Type your current password in the Old Password field.
3. Type a new password in the New Password field.

Rules for entering a new password:

- The new password must have a minimum length of 8 characters.
- It must contain at least 1 uppercase and 1 lowercase letter and a minimum of 2 non-alphabetic characters.
- It cannot use previous passwords, or variations of previously used passwords. Passwords must be different than the 4 previously used passwords.
- The user ID or name cannot be used as part of the new password.

If the new password fails to meet any of these requirements, an alert message will pop up and the user will be prevented from saving the invalid password.

4. Type the new password exactly as you entered it in Step 3 in the Verify new password field.
• If the Old password and the New password are the same, an error message displays.

• If the New password and Verify password do not match, an error message displays.

5. The user’s email address pre-populates the Email field if the user currently has a stored value. Otherwise, the field will appear empty and the user will be required to enter an email address.

6. If security answers are already stored in the database, the specific question that was saved will be the selected value in each security question drop-down list and the string “--Answer On File--” will appear on each answer field; otherwise, the drop-down lists will display “--Select--” and the answer fields will be blank.

7. Click Save Changes to save the new password. You can continue to use Office throughout the current session. The next time you log in, you must use your new password to gain access.

Session Time-out

If your workstation is inactive for several minutes, a re-authentication window will pop up as shown on the next illustration:

Please Re-authenticate The User: newuser

Password

Log In  Cancel To Logout

If this happens, re-enter your password and click Log In to continue working on the same request page you were on prior to being timed-out. If possible, data last used in the request page will be restored.

User Account Information [Manage Users?]  

The Manage Users link on the Setup tab invokes the User Account Information screen. This service is available to all users.
At the bottom of the screen there is a list of all the active users who share the same location ID as the current user and who have any of the following services in their job description:

- User Management
- Site Administration or
- Primary Contact.

By default, these fields are populated with data currently contained in the Office database. If the default value of any field is blank then the user is required to enter data before submission. All fields preceded by a red asterisk (*) must be entered before saving data.

The table below describes the valid format for each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>Accepts up to 50 alphanumeric characters (can include a space, period, dash and single quote).</td>
</tr>
<tr>
<td>Last Name</td>
<td>Accepts up to 50 alphanumeric characters (can include a space, period, dash and single quote).</td>
</tr>
<tr>
<td>Last 4 digits of SSN</td>
<td>4 numeric characters</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>MMDDYY, MMDDYYYY or “t” for today’s date</td>
</tr>
</tbody>
</table>

If the user saves revisions for any field, the changes will replace the current value of that field in the Office database.

**Security Questions**

It is important to answer both security questions and save them to be able to reset your password in the future.
• If answers to the security questions have not been stored the security question drop down menus will display “--Select--” and the answer fields will appear empty as shown below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Accepts up to 50 alphanumeric characters (can include a space, period, dash and single quote).</td>
</tr>
<tr>
<td>First Name</td>
<td>Accepts up to 50 alphanumeric characters (can include a space, period, dash and single quote).</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>MMDDYY, MMDDYYYY or “t” for today’s date</td>
</tr>
<tr>
<td>Last 4 (digits) of SSN</td>
<td>4 numeric characters</td>
</tr>
<tr>
<td>Email</td>
<td>User’s email address. This field accepts up to 80 characters.</td>
</tr>
<tr>
<td>Security Questions 1 &amp; 2</td>
<td>The user must enter a different question for each security question. Both fields accept a maximum of 255 characters and may consist of letters, numbers, spaces and special characters. A minimum of 6 alpha-numeric characters is required.</td>
</tr>
</tbody>
</table>

If the user saves changes for any field, the changes will replace the current value of that field in the Office database.

Admin User Account Request

The Admin User Account Request service is visible to users that do not have the User Management service. Access the Admin User Account Request service by selecting Setup > Create Admin.
This service allows a customer to request that an admin user be created where an account does not have one. The message at the top of the Administrative User Account Request screen (shown below) guides the customer through the request process.

**Administrative User Account Request**

If your user account needs to be upgraded to have administrative rights, or you would like to add a person as an administrator who is not a current user, please complete the form below, print it out and fax it to (615) 238-0016. Please include with your fax a second page stating the reason for your request (for example: your prior administrator is no longer with your organization, no one was previously setup as an administrator). Please be sure that your explanation is written on the official letterhead of your office or facility. This note must be signed by a physician, office manager or other decision making executive in your organization.

<table>
<thead>
<tr>
<th>Requesting User:</th>
<th>Tax ID:</th>
<th>Customer ID:</th>
<th>Phone:</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>123654567</td>
<td>00000123456</td>
<td>700-555-8882</td>
</tr>
</tbody>
</table>

*Select one:*  
1. Upgrade existing to be an Admin User  
2. Create New Admin User

<table>
<thead>
<tr>
<th>Last Name</th>
<th>First Name</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>abbot</td>
<td>clement</td>
<td><a href="mailto:cabbc@gmail.com">cabbc@gmail.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date of Birth</th>
<th>Last 4 of SSN</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/1973</td>
<td>1234</td>
</tr>
</tbody>
</table>

Return to Home Page  
Print

**Manage Users**

The **Manage Users** link is available to admin users who have this service set up.

Usually they are office or practice administrators. Admin users can manage location and user enrollment data through this service. Admin users have the following capabilities:
Office - Real Time Transactions

- Add new locations
- Manage locations
- Add new users
- Edit user data
- Reset passwords
- Activate or deactivate users from Office

**Note:** If you are not an “Admin” user, you may skip to “Manage Favorite Lists” on page 30 of this guide.

Upon **Selecting Setup > Manage Users**, the Location List and User Management List screen displays.

![Location List and User Management List](image)

**Note:** The Location List will be hidden by default, displaying only the user list. To view the location list, select the **Show Location List** button.

![Location List](image)

This screen contains a list of all the locations associated with the organization. By selecting the individual locations, a user list will display of all the users who share that same location.
Location List Management

Admin users have the ability to create new locations and manage existing locations for their organization through the Manage Users link.

Note: The location list will be hidden by default, but the list can be viewed by selecting Show Location List from the menu above the location and user lists.

Add a Location

Admin users can add locations for their organizations that will allow for eligibility checks, but if the new location is going to process claims, the admin user should contact Emdeon customer support to set up the claims processing service for the new location.

Follow these steps to add a new location:

1. **Select Setup > Manage Users.** The Location and User List Management screen displays.

2. **Click Add Location** from the menu above the location and user lists. The “Add Location” screen will appear.
Note: While the “Add Location” modal window is open, the rest of the screen will be inactive. The “Add Location” window has the ability to “maximize” the screen or “exit” it in the top right hand corner of the modal window.

3. Enter all identifying information for your organization. The following table describes the valid format for each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
<td>The full name of the organization associated with the new location. Six (6) to forty (40) alphanumeric characters.</td>
</tr>
<tr>
<td>Organization Tax ID</td>
<td>The tax ID associated with the new location. Nine (9) digits.</td>
</tr>
<tr>
<td>Address 1</td>
<td>The street address of the new location. One (1) to forty (40) alphanumeric characters.</td>
</tr>
<tr>
<td>Address 2</td>
<td>Additional address information for new location. One (1) to forty (40) alphanumeric characters.</td>
</tr>
<tr>
<td>City</td>
<td>The city of mailing address for new location. One (1) to twenty (20) characters.</td>
</tr>
<tr>
<td>State</td>
<td>The state of the mailing address for new location. Drop-down selection.</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>The ZIP code of the mailing address for new location. Five (5) or nine (9) digits.</td>
</tr>
</tbody>
</table>
4. Enter the user data for the primary contact for the new location under the “User Information” section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The login name of the primary contact for the new location. Six (6) to thirty (30) characters.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the primary contact for the new location. One (1) to fifty (50) characters.</td>
</tr>
<tr>
<td>Middle Initial</td>
<td>The middle initial of the primary contact for the new location. One (1) character.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the primary contact for the new location. One (1) to fifty (50) characters.</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>The date of birth of the primary contact for the new location. MMDDYY, MMDDYYYY or “t” for today’s date.</td>
</tr>
<tr>
<td>Last Four Digits of SSN</td>
<td>The last four digits of the primary contact’s social security number. Four (4) digits.</td>
</tr>
<tr>
<td>Phone</td>
<td>The primary contact’s phone number. Ten (10) digits.</td>
</tr>
<tr>
<td>Fax</td>
<td>The primary contact’s fax number. Ten (10) digits.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The primary contact’s email address. One (1) to three-hundred-and-twenty (320) characters. Special characters allowed are hyphen (-), underscore (_), period (.), and the at sign (@).</td>
</tr>
</tbody>
</table>

5. Click “Submit” to create the new location, or select “Close” to exit the “Add Location” screen.

Note: A temporary password is assigned for the administrative user assigned during the setup of the new location and is displayed in the message. This user will be required to enter a new password on his/her first login.

Edit a Location
Admin users can edit location information, including organization information and contact information.
Follow these steps to add a new location:

1. **Select Setup > Manage Users.** The Location and User List Management screen displays.
2. Click **Show Location List**, and the list of locations will appear.
3. Click the location you wish to edit in the Location List. The Edit Location submenu will appear.

4. Click **Edit Location**. The Edit Location screen will appear.

   ![Edit Location Screen](image)

   **Edit Location: Dr. Smith's Main Street Clinic**

   - **Organization Name:** Dr. Smith's Main Street Clinic
   - **Organization Tax ID:** 999999999
   - **Address:** 3056 Lebanon Pike
   - **City:** Nashville
   - **State:** Florida
   - **Zip/Postal Code:** 33169

   ![Submit and Close Buttons](image)

   **Note:** While the “Edit Location” modal window is open, the rest of the screen will be inactive.

5. Modify the location data as needed. The new data will replace the data on file.
6. When finished, click **Submit** to save the updated location record.
User List Management

Admin users have the ability to find existing users, create new users, edit user information, configure claim report emails (if enrolled), reset passwords, and activate or deactivate users through the Manage Users link.

Admin users can view user information about individuals at each location, including the following information:

- User Name
- User ID
- Status
- Job Description
- Last Session Date
- Locked Out Status

Find an Existing User

Admin users can search individual users at each location by using the “Find User” button at the top of the User Management page.

1. Select Setup > Manage Users. The Location and User List Management screen displays.
2. To search for a user at a location, click the “Find User” button at the top of the “User Management” page. The “Find User” screen appears.
3. Enter the User Name, Last Name, and First Name of the user you are searching for.
4. Click “Find User” to submit your search, or select “Close” to exit the “Find User” screen without submitting your search.

**Add a New User**

Admin users can add users to the Office system by creating logins for the individuals, but the admin user will need certain identifying information from the new user to set up the user account. Admin users also have the ability to set permissions for the new user (basic or admin privileges) and configure email settings for the claim report system (if enrolled).

Follow these steps to add a new user:

1. **Select Setup > Manage Users.** The Location and User List Management screen displays.

2. Click the Add New User button. The Add New User screen displays.
Note: While the Add New User modal window is open, the rest of the screen will be inactive. The Add New User window has the ability to “maximize” the screen or “exit” it in the top right hand corner of the modal window.

3. Enter user data. All fields preceded by a red asterisk (*) are required. The following table describes the valid format for each field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Valid Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>The new user’s login ID. Six (6) to forty (40) characters. Note: If the user ID already exists in the system, a message displays instructing the user to choose another login ID.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the new user. One (1) to fifty (50) characters.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the new user. One (1) to fifty (50) characters.</td>
</tr>
<tr>
<td>Last 4 of SSN</td>
<td>The last four (4) digits of the new user’s Social Security Number.</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>The date of birth of the new user. MMDDYY, MMDDYYYY format or “t” for today’s date.</td>
</tr>
<tr>
<td>Email</td>
<td>The new user’s email address. One (1) to three-hundred-and-twenty (320) characters. Special characters allowed are hyphen (-), underscore (_), period (.), and the at sign (@).</td>
</tr>
</tbody>
</table>

4. If applicable, check the “Is A Site Administrator” box to grant the new user admin rights.

5. If applicable, check the “Receive Claim Reports” box to allow the user to receive claim reports.

Note: After checking the “Receive Claim Reports” box, the “Add New User” modal window will expand with a list of claim reports to choose for the new user to receive.
6. Click Save to save the new user record. A confirmation message will appear indicating that the record was successfully saved.

Note: A temporary password is assigned for the new user and is displayed in the message. The user will be required to enter a new password upon his/her first login.

7. To clear all the fields on the screen without saving any changes click Reset.

8. To return to the User List screen click Close. Do not click the Back button on your browser since this may cause unpredictable results.

Edit User Information

Admin users can edit the information of existing users. This screen also allows admin users to change the claim reports email settings for existing users (if enrolled).

1. To modify a user’s record, select Setup > Manage Users. The Location and User
List Management screen displays.

2. Click the user name you wish to edit in the User List. The “Edit User” menu will appear.


Note: While the “Edit User” modal window is open, the rest of the screen will be inactive.

4. Modify user data as needed. The new data will replace the data on file.
5. If applicable, check the “Site Administrator” box to grant the user admin rights.
6. If applicable, check the “Receive Claim Reports” box to allow the user to receive claim reports.

Note: After checking the “Receive Claim Reports” box, the “Edit User” modal window will expand with a list of claim reports to choose for the new user to receive.

7. When finished, click **Save** to save the updated user record.
8. To return all fields to their previous data, click **Reset**.
9. To return to the “User List” screen click **Close**. Do not click the **Back** button on your browser since this may cause unpredictable results.

**Reset a Password**

Admin users have the ability to reset user passwords in the event that users forget their passwords or have been locked out due to inactivity or too many invalid login
attempts.

**Note:** If the password reset is successful, the new password will only be valid for one-time use. The user associated with the password will be asked to create a new password upon login.

1. To reset a password, select **Setup > Manage Users**. The **Location and User List Management** screen displays.

2. Click the user name for which you wish to reset the password for in the User List. The “Edit User” menu will appear.

4. Enter a **New Password**, making sure the selected password has a minimum of 8 characters.

5. Repeat the same password in **Confirm New Password**.

6. Click **Save** to save the new password.

7. If there is a mismatch between New Password and Confirm Password you will be asked to re-enter both fields.

8. To return all fields to their previous data, click **Reset**.

9. To return to the User List screen click **Close**. Do not click the **Back** button on your browser since this may cause unpredictable results.

### Activate or Deactivate a User

Admin users can activate or deactivate users on the Office system.

1. To change the activation settings on a user’s account, select **Setup > Manage Users**. The **Location and User List Management** screen displays.

2. Click the user name you wish to make changes to. The “Edit User” menu will appear.
3. Click “Activate” or “Deactivate” from the menu. Immediately after clicking “Activate” or “Deactivate,” the user status should change in the Status column. An “INACTIVE” user status:

The status will change to “ACTIVE” for the user immediately after clicking “Activate” on the “Edit User” menu.
Manage Favorite Lists

Manage Favorite Lists allows you to add, delete, and edit providers and codes for all of your favorites lists from a single screen. You may also view favorite lists created by other users within your work group. Data stored in favorite lists is used to create real time requests. The default list view is “Requesting Provider List.”

**Note:** Only Administrative users can add, remove or modify requesting providers.

**Favorite Lists** allows users to select all the codes that are applicable to their practice. Clicking the “All Payers” button prior to editing a list of favorites lets you specify changes that apply to all payers.

In addition to provider favorites, **Favorite Lists** allows storing and maintaining commonly used Procedure (CPT), Diagnosis (ICD9) and Dental (ADA) codes, as well as Service Type, Place of Service and Specialty codes.

Group Favorites

Group Favorites include all favorites created by users associated with an Organization as defined during registration. Clicking the “Group Favorites” link, located on the upper right portion of the **Favorite Lists** screen, displays a combined list of all Favorites entered by individual users within a work group. You may edit or delete your own entries as well as those made by other users within your group.

**Note:** Group Favorites is the only available view on the Requesting Provider page.

Manage Provider Favorites

Provider lists allow users to add provider demographic data to favorites or modify providers already in favorites. When a provider is selected from a drop-down list on a request page, all provider-related fields are automatically populated.

**Note:** Only Administrative users can add, remove or modify requesting providers. Other users will see a “View” link in the **Action** column.

To add or remove data from Requesting or Service Provider lists:

1. Select a favorite list by clicking one of the links located at the top of the page. The default list view is “Requesting Provider.” A list of providers for all payers displays.

2. To manage provider data for specific payers, select the desired payer from the drop-down list and click the “Selected Payer” button. This filters the list to include only records associated with the selected Payer.

3. Select the links located under the **Action** column, to the right of the screen, to either “Edit” or “Remove” provider records.

Update Provider ID Drop-down Lists

When adding or removing providers from a list of favorites, keep in mind that:
Newly added providers will not appear in the Provider ID drop-down lists until you log out and log in, or click the **Update Drop-down Lists** button on the **Favorite List** screen.

Likewise, deleted providers will not be removed from the Provider ID drop-down lists until you log out and log in, or click the **Update Drop-down Lists** button on the **Favorite List** screen.

In addition, providers added by other users will not be visible to you until you log out and log in, or click “Edit” next to the Provider ID field (shown below) or click the **Update Drop-down Lists** button on the **Favorite List** screen.

Sample drop-down list on request page next to Provider ID field.

In addition, providers added by other users will not be visible to you until you log out and log in, or click “Edit” next to the Provider ID field (shown below) or click the **Update Drop-down Lists** button on the **Favorite List** screen.

![Sample drop-down list](image)

**Edit a Provider Record**

On the **Favorite Lists** screen click the “Edit” link next to the Provider record you wish to modify. The **Edit Provider** screen for the selected provider displays, as shown on the next illustration.

**Note:** Only Administrative users can edit requesting providers.
The only required fields in the provider add/edit screens are:

- Last Name (or Organization Name) is always required
- First Name is required if the provider is an individual rather than an organization
- At least one of the following is required: Tax ID, Payer Assigned ID or NPI
- If Payer Assigned ID is entered, the payer must also be identified. Note that if the edit/add screen is accessed from a payer request page, the payer identity will be pre-set to the current payer.
- The nickname field (although not required) should be entered, if possible, as it provides a short description that will be displayed in drop-down lists to help identify the owner of provider IDs.

**Add a New Provider**

The following procedure describes how to add new providers to favorites.

**Note:** Only Administrative users can add requesting providers.

From the Provider Favorites Lists click the **New Provider** button. The **New Provider** screen appears as shown on the next illustration.
1. Before entering data, be sure to check the “Select from existing provider” list to verify that the provider has not been previously entered for a different payer.

2. The only required fields in the provider add/edit screens are:
   - Last Name (or Organization Name)
   - Tax ID, Payer Assigned Provider ID or NPI. Note that if the Edit Provider/New Provider screen is accessed from a payer request page, the payer identity will be pre-set to the current payer.
   - The nickname field (although not required) should be entered, if possible, as it provides a short description that will be displayed in drop down lists to help identify the owner of provider IDs.

3. Provider specialty is an optional data element. Users are allowed to enter multiple specialties per provider. To enter multiple specialties, select a specialty from the Available Specialties list and then click Add. Only those specialties listed in the “Provider’s Specialties” list have been stored for the current provider.

   The specialties listed in the “Available Specialties” list may be customized by using the Edit button.

**Online Payer Enrollment**

**Note:** Payer Enrollment is a task reserved for administrative users.

In some cases, when adding or editing Requesting Providers, an additional step will display on the Provider screen, below Step 3, as shown on the next illustration. This
step only displays for payers that support online enrollment.

The asterisk (*) next to the payer name in the illustration indicates the current payer supports online enrollment.

Payer enrollment involves creating a provider-payer association by entering a Payer Assigned Provider ID, a Secondary Payer ID if applicable, and checking the enrollment box. A provider favorite can be saved with just a Tax ID or NPI. In this case, no true payer association is made and thus no payer enrollment checkbox is needed. It is when the user attempts to create a Payer Association that enrollment is required.

Since only administrative users can add or edit requesting providers, only they will see the enrollment check box.

The following scenarios cause this dynamic step to display:

- On the New Provider screen if the selected payer supports additional enrollment.
- On the New Provider screen if the user selects an existing provider, the currently selected payer supports additional enrollment and this provider does not have a Payer Assigned Provider # associated with the selected payer.
- On the Edit Provider screen if the selected payer supports additional enrollment and the Payer Assigned Provider # is empty.

If a payer supports enrollment, an asterisk (*) will appear next to the payer name in the Payer list drop-down, as shown on the following illustration:
The asterisk (*) next to the payer name appears only on the *Requesting Provider* page.

**Note:** If the user modifies existing data but does not enter a Payer Assigned Provider #, the checkbox may be displayed but it will be ignored when the user clicks the **Save** button. This is true regardless of whether the box is checked or not.

Once the checkbox is on the *Provider* screen, if the selected payer changes to a payer that doesn’t support additional enrollment, the checkbox will be removed from the screen, as shown below. The checkbox will also be removed if the user selects an existing provider who already has a Payer Assigned Provider # associated with the payer.

A Provider Favorite is considered to be already associated with a payer if there is currently a Payer Assigned ID for the provider/payer.

### Required Fields for Payer Enrollment

When creating a payer/provider record for a payer that supports online enrollment, the following fields are required: Street, City, State, Zip, Contact Name, both Provider ID and Tax ID. Also, the new enrollment checkbox must be checked.

When editing an existing Provider for a payer who supports additional enrollment and the Payer Assigned Provider # already exists, any change to the existing data will...
enforce all the same edits as when the provider ID was first saved but the enrollment checkbox will not appear on the screen. Required data can be modified but not completely removed.

**Medical Codes Favorites Lists**

Medical codes provide key information to payers for determining how claims are reimbursed.

Manage Favorites allows storing and maintaining commonly used procedure (CPT), diagnosis (ICD9) and dental (ADA) codes, as well as Service Type and Place of Service Codes. These codes can later be retrieved for creating eligibility requests and referrals/authorizations.

- Procedure codes describe medical services performed on a patient.
- Diagnosis codes describe diagnoses and diseases.
- CDT4 codes describe dental procedures and services.
- Place of Service codes are used to specify the type of entity where medical services are rendered.
- Type of Service codes are used to classify medical services performed on a patient.

**Add Procedure, Diagnosis and CDT4 Codes**

This procedure applies to Procedure, Diagnosis and CDT4 Codes. You may access this function by selecting Setup > Medical Codes or by selecting Setup > Providers.

1. From the Favorite Lists screen, select the list of codes you want to customize from the menu, (“Procedure Codes” “Diagnosis Codes” or “CDT4 Codes”). A full list of codes displays.
2. Click Find Code. A search screen appears.
3. On the Find Code screen enter search criteria. Wild card searches are allowed on the keyword field as shown on the next sample illustration.
4. Click Submit. A list of codes matching your search criteria appears.
5. Select one or more codes by clicking the check box next to it.
6. When finished click Add to Favorites. A message displays indicating the selected
code(s) have been successfully added to the list.

7. Click **Return to Request** to return to the list of codes. (Do not click the **Back** button on your browser since this may cause unpredictable results). Any newly added codes will appear on the request screens for the selected payer(s).

8. Click **To Favorite List** to return to the main Favorites screen.

9. Click **Search Again** to search for another code.

### Add Service Type and Place of Service Codes

This procedure applies to Service Type and Place of Service Codes. You may access this function by selecting **Setup > Providers**.

1. From the **Favorite Lists screen**, select the list of codes you want to customize from the menu, (“Service Type Codes” or “Place of Service Codes”). A full list of codes displays.

2. Select the codes you want to appear on the list by clicking on the check box next to them.

3. Click **Save**. The newly added codes will appear on the Eligibility and Service Review screens for the selected payer(s).

4. Alternatively, click **Reset** or **Clear All** to clear all the selections.

### Remove a Medical Code

To Remove a Medical Code return to the **Favorites List screen** and click the “Remove” link next to the code you wish to remove.

### Specialty

A list of specialties opens when the user chooses the **Specialty** option on the **Favorites List** screen.

As with service type and place of service, Office allows users to customize the specialty list. Some payers support only a small number of specialties while others allow users to select any existing specialty. Users can create a custom specialty list containing only those specialties applicable to their practice.

Note that there are three custom lists of specialties:

- payer specialty
- user specialty
- provider specialty

The first list is the payer specialty list and includes those specialties supported by the current payer. This list can include all specialties. The second list is the user specialty list which contains those specialties a user has chosen to see displayed. If the user hasn’t specified any specialties, then all specialties are available to the user. The third list is the provider specialty list which includes those specialties that have been saved as part of a provider's profile.
When a user opens any page that contains a specialty list, the list contents will change depending on whether or not the identity of the provider is known. Where a specialty list describes a provider who is stored in favorites, then the options on the specialty list will be limited to those specialties which are saved for the provider and which are also supported by the payer. However, if a provider has not been identified, or if the provider is not saved in favorites, or if the provider has no specialties stored in favorites, than the specialties listed will be only those that are on the user’s favorites list and also supported by the payer.

To further assist with specialty selection, a find feature is available to allow users to search for a specialty by keyword. Specialties found in the dictionary can be stored in the user favorites list and then selected in the current transaction, if supported by the payer.

### Taxonomy Code Favorite List

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>207ND800X</td>
<td>Dermatology : Dermatopathology</td>
<td>Remove</td>
</tr>
<tr>
<td>207RC000X</td>
<td>Internal Medicine : Cardiovascular Disease</td>
<td>Remove</td>
</tr>
<tr>
<td>207RE010X</td>
<td>Internal Medicine : Endocrinology, Diabetes &amp; Metabolism</td>
<td>Remove</td>
</tr>
<tr>
<td>207VE010X</td>
<td>Obstetrics &amp; Gynecology : Reproductive Endocrinology</td>
<td>Remove</td>
</tr>
<tr>
<td>207SO005X</td>
<td>Orthopedic Surgery : Sports Medicine</td>
<td>Remove</td>
</tr>
<tr>
<td>29510800X</td>
<td>Physical Therapist : Orthopedic</td>
<td>Remove</td>
</tr>
<tr>
<td>2471C1101X</td>
<td>Radiologic Technologist : Cardiovascular-Interventional Technology</td>
<td>Remove</td>
</tr>
</tbody>
</table>

The **Find Code** button below the list of specialties invokes a specialty search screen. The following image illustrates a search for specialties containing the character string “card.”

### Find Specialty Code

**Step 1 - Enter search criteria**

To search on multiple key words, separate them with a comma.

- **Code Key Words:** CARD
- **Code Value:**
- **Max Result Rows:** 20

**Step 2 - Submit Request**

- Submit
- Reset
- Return to Previous Screen

The results of this search appear on the next illustration.
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>163WC3500X</td>
<td>Registered Nurse : Cardiac Rehabilitation</td>
</tr>
<tr>
<td>207RC0000X</td>
<td>Internal Medicine : Cardiovascular Disease</td>
</tr>
<tr>
<td>207RC0001X</td>
<td>Internal Medicine : Clinical Cardiac Electrophysiology</td>
</tr>
<tr>
<td>207R10011X</td>
<td>Internal Medicine : Interventional Cardiology</td>
</tr>
<tr>
<td>207UN0001X</td>
<td>Nuclear Medicine : Nuclear Cardiology</td>
</tr>
<tr>
<td>2080P0002X</td>
<td>Pediatrics : Pediatric Cardiology</td>
</tr>
<tr>
<td>2086C0000X</td>
<td>Thoracic Surgery (Cardiothoracic Vascular Surgery)</td>
</tr>
<tr>
<td>2251C2600X</td>
<td>Physical Therapist : Cardiopulmonary</td>
</tr>
<tr>
<td>246W00000X</td>
<td>Technician, Cardiology</td>
</tr>
<tr>
<td>246X00000X</td>
<td>Spec/Tech, Cardiovascular</td>
</tr>
</tbody>
</table>
Module Three – Edit Payer List [Payers]

Objectives
In this section you will learn how to do the following:

- Edit the Payer List
- Use the Request Page features

Overview
Users can customize the payer drop-down lists on all the request pages by editing the payer list. The payer list is accessed by selecting Setup > Payers on the home page or by clicking the Edit Payer List button on any the request screens.

The presence of an asterisk (*) next to a payer name indicates that additional payer specific enrollment is required prior to using this payer. To obtain the enrollment forms, select Setup > More and click on the “Payer Enrollment” link.

Edit the Payer List
Follow these steps to edit the payer list:

1. From the home page, select Setup > Payers or click the Edit Payer List button from any of the request screens. This opens the Payer List Personalization window.

<table>
<thead>
<tr>
<th>Select</th>
<th>Transactions (Current list in bold, stemming from transaction)</th>
<th>Payer Name</th>
<th>Batch Payer ID</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>*Check Eligibility</td>
<td>Acadia National</td>
<td>AC000101</td>
</tr>
<tr>
<td></td>
<td>Check Eligibility Check Claims</td>
<td>Advanta Freedom</td>
<td>C0000101</td>
</tr>
<tr>
<td></td>
<td>*Check Eligibility HCS Review Request HCS Review Inquiry Check Claims</td>
<td>Astra</td>
<td>ASTNA</td>
</tr>
<tr>
<td></td>
<td>Check Eligibility Check Claims</td>
<td>Astra Long Term Care</td>
<td>E0000101</td>
</tr>
<tr>
<td></td>
<td>Check Eligibility Check Claims</td>
<td>AFTRA Health Fund</td>
<td>E0000101</td>
</tr>
</tbody>
</table>

Prior to submitting transactions to payers indicated with an “*”, additional payer enrollment is required. Select “Payer Enrollment” from the home page to obtain the enrollment forms.
The available transactions for each payer are listed in the Transactions column. The Batch Payer ID column displays the payer ID for real-time payers. This information is needed for batch import.

2. Choose the payers you wish to work with by checking the appropriate boxes or select all payers by clicking the Select All button.

3. Uncheck any payers you do not need on your list.

4. After selecting the payers you wish to add or delete, scroll down to the bottom of the screen and click Save.
   - To return to the previous settings without saving any changes click Reset.
   - To return to the previous page click Close.
   - To clear all selections, click Clear All.

5. If the payer drop-down list on a request page does not update after making changes to the payer list, click the Refresh button on your browser’s menu to update the list or click the Reset Page button on the request page.
   Any changes made to the payer list will be reflected on the payer drop-down lists.

Request Page Features
This information applies to Eligibility, Service Review Request or Inquiry, and Claims.

Page Navigation
Be sure to always use the navigation buttons on a screen to go to the previous or next screen. Do not use the Back button on your browser, particularly when reviewing Eligibility responses, since this may cause unpredictable results. Instead use the Return to Request button to navigate to the previous page.

Payer Drop-down
The first field on every real-time request screen in Office is a payer drop-down list.

An asterisk (*) indicates additional payer enrollment is required prior to submitting transactions to that payer. Contact [whom?] for further information or select Setup > More and click on the “Payer Enrollment” link to obtain the enrollment forms.
Over the next few months, each payer request page will be enhanced to replace the “Provider ID” text field with a drop down list.

For non-administrative users, the Select button next to the Requesting Provider ID field accesses the Requesting Provider Favorites List in View mode. This allows users to select from a list of Requesting Provider Favorites.

The following illustration shows the Provider ID drop down list:

Clicking on the downward pointing arrow next to the Provider ID field opens a list of available providers.
When a provider is selected from the list, all of the following fields related to same provider are automatically populated, if the user has saved these details in the provider favorites list:

- Provider ID
- First Name
- Last/Org name
- Address
- City
- State
- Zip
- Role
- Specialty
- Contact Name
- Contact Phone
- Contact Fax
- Individual/Organization
- Provider Type

A few payers require additional provider information in their requests. Over the next few months, request pages will be enhanced to pre-populate as many of these additional fields as possible.

**Service Type and Place of Service Fields**

On some payers you will notice a new **Edit** button next to the Service Type list. This button opens a Service Type favorites list, in which users can customize what service types are meaningful to their office. A similar functionality is also available for the Place of Service list which is commonly used in referrals and authorizations.

The default value for the two lists, Service Type and Place of Service, is the value that was last used for a given payer.

When the **Edit** button is selected a list of all possible service types is displayed for selection, as follows:

<table>
<thead>
<tr>
<th>Customize Service Type Favorite List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service Type Codes</strong></td>
</tr>
<tr>
<td>☐ Dental Care (35)</td>
</tr>
<tr>
<td>☐ Health Benefit Plan Coverage (30)</td>
</tr>
<tr>
<td>☐ Medical Care (1)</td>
</tr>
<tr>
<td>☐ Vision (Optometry) (40)</td>
</tr>
</tbody>
</table>

The above window opens when **Edit** is selected from the MMO eligibility. Compare this
In each case, only those service types supported by the payer are displayed. To customize the full list of service types, select Setup > Providers and navigate to the Service Type Code Favorite List. Place of Service lists are also filtered by payer, if applicable. A complete Place of Service list is available by selecting Setup > Providers as well.
Module Four – Eligibility

Objectives
In this section you will learn how to do the following:

· Submit an eligibility request
· Use the card swipe
· Use the Patient Responsibility Estimator (PRE)
· Use the Contract Rate Utility

Overview
The Eligibility service allows users to obtain eligibility and coverage information on specific services for claims and referrals.

Key Features

· Fast access to dozens of government, commercial, and managed care plans
· Individual and batch functionality for improved productivity
· Time-saving batch management features: Sort, Move, Copy, Delete
· Batch Import feature to eliminate data entry - Interfaces with any PMS or HIS
· Obtain vital, accurate eligibility and billing information in seconds to support accurate claims submission
· Increase billable accounts, decrease manual tasks and phone calls, eliminate claim rejections

Submit an Eligibility Request

Follow these steps to check patient eligibility.

1. Gather your search criteria information:
   · Patient’s member number, or
   · Patient’s Social Security number, or
   · Patient’s member name and date of birth

2. Select Eligibility from the main menu.

3. Select a payer from the drop-down list.
   Note: The eligibility request screen and required fields will vary depending on the payer.
4. Enter the patient’s information gathered in Step 1.
5. Add the date for which you are checking eligibility, and specify whether you want family information and eligibility history included in the results.

   **Note**: The data required to complete an Eligibility request varies depending on the payer.

   Some payer forms have a **Service Type Code** drop-down list in the search criteria. Selecting a specific service type code will improve the benefit detail returned. The STC selection defaults to the last code used for that payer. The **Edit** button opens a screen that allows editing the list to include only those service types relevant to the user’s practice.

   The following illustration shows a completed **Check Eligibility** form:

6. Click **Send to Payer** to launch the search. Your patient data is returned as shown on the following illustration:
Office - Real Time Transactions

7. Review the information. If applicable, click on any of the links to see additional eligibility data.
8. Scroll down to view the complete eligibility information.
9. The buttons Check Claims, HCS Review Inquiry and HCS Review Request take the user to these transaction screens. Most of the fields on the new transaction screen will be populated with data from the eligibility transaction.
10. Click Save Response to Batch to save the response to a new or existing batch. The following window appears:

   ![Image]

   **Note:** The window displays the name of the last batch you used while batching was turned on. If you have never turned batching on, the pop-up displays either a default batch name (Default_<your initials>) or the name of the first batch on the Batch Manager list.

   Do one of the following:
   - To save the response to an existing batch, choose the batch from the drop-down list. Click Refresh List if your batch is not displayed in the list.
   - To save the response to a new batch, enter the batch name. Click Save.
   **Note:** The Save Response to Batch link appears only if batching is off.
11. Click Return to Request to return to the Eligibility window. Do not click the Back button on your browser since this may cause unpredictable results.

Card Swipe

The card swipe feature allows users to retrieve patient information from swipeable insurance cards (only available for supported payers). The card swipe option automates the entry of a member ID or ID card number. The user is still responsible for entering all other provider and service information.
12. Select Eligibility from the main menu.
13. Select a payer from the drop-down list in the Step 1 area.
14. In the Step 2 area, select the desired search.
15. Click the Read Card button, located next to the field which can accept the card swipe data (such as Member ID field).
   **Note:** Only payers who support the card swipe feature will have this option on the payer’s screen.
A dialog box will appear instructing the user to “Please swipe card now.”

16. Swipe the member’s ID card.

Patient Responsibility Estimator (PRE)

Overview
The Patient Responsibility Estimator (PRE) is used to estimate patient responsibility prior to or at the point of service, via robust and meaningful eligibility information that details patient responsibility. The PRE works in conjunction with the Check Eligibility function of Emdeon Office to determine eligibility and calculate the Patient Responsibility Estimate. However, the required input fields for a PRE transaction differs from a basic eligibility inquiry. Once the search is performed, the results are displayed immediately.

Key Features
- Estimates real-time patient responsibility at or before point of care
- Calculation considers patient’s eligibility benefits as well as provider’s allowed amount with patient’s health plan
- Print-out available to give patient, showing benefits applied in PRE calculation (co-pays, deductibles, co-insurance)
- Contract rate upload utility
Submit PRE Transaction

1. Select **Eligibility** from the main menu. The standard Check Eligibility page appears.

2. In the Step 1 area, select the **payer** (from the drop-down list) for which the PRE transaction is going to be run.

3. In the Step 2 area, check the **Patient Responsibility Estimator** checkbox. The Step 2 search criteria fields will refresh on the screen to accommodate the PRE transaction.
4. In the refreshed Step 2 area, enter the required provider and patient identifying information. Required fields are marked with a red asterisk (*). Conditional fields are marked with a blue asterisk (*).

5. After reviewing the entered information to ensure its accuracy, select the Send to Payer button in the Step 3 area.

6. A detailed Eligibility and Benefit Information response will be returned like the one below.
Note: If provider is setup to accept payments, select Charge to enter credit card information for payment processing. A pop-up window appears.

Click Save Response to Batch to save the response to a new or existing batch. A pop-up window appears.

Note: The window displays the name of the last batch you used while batching was turned on. If you have never turned batching on, the pop-up displays either a
default batch name (Default_<your initials>) or the name of the first batch on the Batch Manager list.

7. Do one of the following:
   - To save the response to an existing batch, choose the batch from the drop-down list. Click Refresh List if your batch is not displayed in the list.
   - To save the response to a new batch, enter the batch name. Click Save.

   Note: The Save Response to Batch link appears only if batching is off.

8. Select the Return to Request button at the bottom of the page to return to the PRE data entry form. Do not use the Back button on your browser, particularly when reviewing Eligibility and PRE responses, since this may cause unpredictable results.

Contract Rate Utility

Overview

Import Contract Rates works with the Patient Responsibility Estimator (PRE) to estimate patient responsibility prior to or at the point of service. Providers have the ability to import their own individualized payer contract rates to create more accurate PRE Eligibility and Benefit Information responses. The Import Contract Rates utility can be accessed by selecting Setup > More and clicking on the "Import Contract Rates" link.

Note: A provider’s Tax ID must be added to the Provider Favorites which can also be accessed by selecting Setup > Providers.

Import Contract Rates

1. Select Setup > More, and click on the "Import Contract Rates" link. A help screen for first-time users appears. If using Import Contract Rates for the first time, please read the instructions before proceeding.

   Note: Requirements are different for Institutional and Professional Providers, so be sure you are using the correct help guide.
2. Information you will need to replace contract rates is listed below. Required fields are marked with a red asterisk (*):

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version #</td>
<td>Reserved for future use</td>
</tr>
<tr>
<td>*Provider Tax ID</td>
<td>Numeric - 9 digits. Provider Tax ID is present in the requesting provider favorites for the location that contains the current user.</td>
</tr>
<tr>
<td>*Payer ID</td>
<td>Alphanumeric - May use either Emdeon standard Claims Carrier IDs or Emdeon Office Payer IDs. For a list of Emdeon Office Payer IDs, please select Setup &gt; Payers and review the right most column.</td>
</tr>
<tr>
<td>Code Qualifier</td>
<td>For Institutional Providers: Valid values for code qualifier can be NUBC or HCPCS. For Professional Providers: Valid value for code qualifier is HCPCS.</td>
</tr>
<tr>
<td>*Code</td>
<td>For Institutional Providers: NUBC Code:  • Must be 4 characters or less.  • Code submitted must match a valid revenue code. For Professional Providers: Character string with length not greater than 5 HCPCS Code:  • Code submitted must match a valid CPT/HCPCS code.</td>
</tr>
<tr>
<td>Code Modifier</td>
<td>For Institutional Providers: NUBC Code:  • Code modifiers are not permitted. For Professional Providers: HCPCS Code:  • Two character code modifier is optional.</td>
</tr>
<tr>
<td>*Allowed Amount</td>
<td>Numeric - The amount per contract that the provider has agreed to accept from the payer. Not to exceed $999,999.99</td>
</tr>
<tr>
<td>Effective Date</td>
<td>Required date format is MM/DD/YYYY.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Required date format is MM/DD/YYYY.</td>
</tr>
</tbody>
</table>

**Note**: Here are a few examples of contract rate add/replace records (depending on included optional fields):

All records included: ,123456789,AETNA,HCPCS,J8610,QE,675.00,02/18/2008,01/01/2009
Required records only: ,123456789,AETNA,,J8610,,675.00
3. After gathering the required information and ensuring the Provider Tax ID has been added to the Provider Favorites, save the contract rates into a comma delimited text file using your Practice Management system, a plain text editor program, or a spreadsheet program. (Your Practice Management system may be able to export contract rates. Check with the vendor if you need help on your Practice Management system.)

Note: If exporting from a spreadsheet program, save the file as a comma delimited file type (.csv) to ensure the file is correctly uploaded. For further help with spreadsheet files, see Create a Contract Rate Spreadsheet on page 58 of this guide.

4. After saving the contract rate file to your local hard drive, select the Proceed to Next Step button from the Import Contract Rates screen. A file upload pop-up window appears.

5. In the Step 1 area, select Provider Type. (Institutional or Professional)

6. In the Step 2 area, select Add/Replace to update contract rates.

7. Select Browse... in Step 3 to locate and select the contract rate file saved on your local hard drive.

8. The Step 4 area offers two selections: Save or Test Only. The Test Only function allows for testing of the contract rate file to ensure it is saved in the correct format. The Test Only option is recommended for new users.

Note: The Test Only option allows users to check the file format of the contract rate file to ensure there are no errors. If there is an error, see Step 10.

9. Select the Start Upload button to begin upload. An Import Status or Import Test Status window appears. This window will notify the user whether the file was correctly uploaded. The Status field will read Successful or Failed.
10. If the upload Failed, select See errors located next to the status update or scroll down to view the errors listed.

Note: The list of errors will notify the user which lines contain errors and how many total errors and warnings were in the file. An error will prevent the user from uploading the contract rates record. A warning will still allow the user to upload the record, but the value in question will be either ignored or changed to the default value. After correcting any errors, resubmit the contract rate file as outlined above.

Replace Contract Rates

Users can replace existing contract rates through the Import Contract Rates utility which can be accessed by selecting Setup > More and clicking on the "Import Contract Rates" link.

Note: The replacement contract rate information to be imported must match the uploaded information for the payer (Payer ID) and provider (Provider Tax ID) already on file.

2. Information you will need to replace contract rates is the same information used in the original contract rate import utility. See the full list of fields in the section Import Contract Rates on page 52 of this guide.

Note: Here are a few examples of contract rate add/replace records (depending on included optional fields):
All records included: ,123456789,AETNA,HCPCS,J8610,QE,675.00,02/18/2008,01/01/2009
Required records only: ,123456789,AETNA,,J8610,,675.00

3. The required information must be entered exactly as it was first imported for the payer and procedure code that is being replaced. Save the contract rates into a comma delimited text file using your Practice Management system, a plain text editor program, or a spreadsheet program. (Your Practice Management system may be able to export contract rates. Check with the vendor if you need help on your Practice Management system.)

Note: If exporting from a spreadsheet program, save the file as a comma delimited
file type (.csv) to ensure the file is correctly uploaded. For further help with spreadsheet files, see Create a Contract Rate Spreadsheet on page 58 of this guide.

4. After saving the contract rate file to your local hard drive, select the Proceed to Next Step button from the Import Contract Rates screen. A file upload pop-up window appears.

5. In the Step 1 area, select Provider Type. (Institutional or Professional)

6. In the Step 2 area, select Add/Replace to update contract rates.

7. Select Browse... in Step 3 to locate and select the contract rate file saved on your local hard drive.

8. The Step 4 area offers two selections: Save or Test Only. The Test Only function allows for testing of the contract rate file to ensure it is saved in the correct format.

Note: The Test Only option allows users to check the file format of the contract rate file to ensure there are no errors. If there is an error, see Step 10.

9. Select Start Upload button to begin upload. An Import Status or Import Test Status window appears. This window will notify the user as to whether the file was correctly upload. The Status field will read Successful or Failed.

10. If the upload Failed, select See errors located next to the status update or scroll down to view the errors listed.

Note: The list of errors will notify the user which lines contain errors and how many total errors and warnings were in the file. An error will prevent the user from uploading the contract rates record. A warning will still allow the user to upload the record, but the value in question will be either ignored or changed to the default value. After correcting any errors, resubmit the contract rate file as outlined above.

Remove Contract Rates

Import Contract Rates allows users to remove contract rates that have previously been imported. The Import Contract Rates utility can be accessed by selecting Setup > More and clicking on the “Import Contract Rates” link.

Note: The contract rate information to be removed must match the uploaded information for the payer (Payer ID) and provider (Provider Tax ID) already on file.

Using the Remove Contract Rates option will remove all contract rates for the identified payer.


2. Information you will need to upload contract rates is listed below. Required fields are marked with a red asterisk (*):

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version</td>
<td>Reserved for future use</td>
</tr>
<tr>
<td>Field</td>
<td>Explanation</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>*Provider Tax ID</td>
<td>Numeric - 9 digits. Provider Tax ID is present in the requesting provider favorites for the location that contains the current user.</td>
</tr>
<tr>
<td>Payer ID</td>
<td>Alphanumeric - May use either Emdeon standard Claims Carrier IDs or Emdeon Office Payer IDs. For a list of Emdeon Office Payer IDs, please select Setup &gt; Payers and review the right most column.</td>
</tr>
</tbody>
</table>

**Note:** Here are a few examples of contract rate remove records (depending on included optional fields):

All records included: ,123456789,AETNA
Required records only: ,123456789

3. After gathering the required information, save the contract rates into a comma delimited text file using your Practice Management system, a plain text editor program, or a spreadsheet program. (Your Practice Management system may be able to export contract rates. Check with the vendor if you need help on your Practice Management system.)

**Note:** If exporting from a spreadsheet program, save the file as a comma delimited file type (.csv) to ensure the file is correctly uploaded. For further help with spreadsheet files, see Create a Contract Rate Spreadsheet on page 58 of this guide.

4. After saving the contract rate file to your local hard drive, select the Proceed to Next Step button from the Import Contract Rates screen. A file upload pop-up window appears.

5. In the Step 1 area, select Provider Type. (Institutional or Professional)

6. In the Step 2 area, select Remove to update contract rates.

7. Select Browse... in Step 3 to locate and select the contract rate file saved on your local hard drive.

8. The Step 4 area offers two selections: Save or Test Only. The Test Only function allows for testing of the contract rate file to ensure it is saved in the correct format.

**Note:** The Test Only option allows users to check the file format of the contract rate file to ensure there are no errors. If there is an error, see Step 10.

9. Select Start Upload button to begin upload. An Import Status or Import Test Status window appears. This window will notify the user as to whether the file was correctly uploaded. The Status field will read Successful or Failed.

10. If the upload Failed, select See errors located next to the status update or scroll down to view the errors listed.

**Note:** The list of errors will notify the user of which lines contain errors and how many total errors and warnings were in the file. An error will prevent the user from uploading the contract rates record. A warning will still allow the user to upload the record, but the value in question will be either ignored or changed to the default value. After correcting any errors, resubmit the contract rate file as outlined above.
Create a Contract Rate Spreadsheet

In order to Import Contract Rates for the Patient Responsibility Estimator (PRE), users must create comma delimited text files that contain all required information listed below. Required fields are marked with a red asterisk (*). Your Practice Management system may be able to export contract rates. Check with the vendor if you need help on your Practice Management system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version #</td>
<td>Reserved for future use</td>
</tr>
<tr>
<td>*Provider Tax ID</td>
<td>Numeric - 9 digits. Provider Tax ID is present in the requesting provider favorites for the location that contains the current user.</td>
</tr>
<tr>
<td>*Payer ID</td>
<td>Alphanumeric - May use either Emdeon standard Claims Carrier IDs or Emdeon Office Payer IDs. For a list of Emdeon Office Payer IDs, please select Setup &gt; Payers and review the right most column.</td>
</tr>
</tbody>
</table>
| Code Qualifier         | For Institutional Providers: Valid values for code qualifier can be NUBC or HCPCS.  
For Professional Providers: Valid value for code qualifier is HCPCS. |
| *Code                  | For Institutional Providers: NUBC Code:  
• Must be 4 characters or less.  
• Code submitted must match a valid revenue code.  
For Professional Providers: Character string with length not greater than 5  
HCPCS Code: Code submitted must match a valid CPT/HCPCS code. |
| Code Modifier          | For Institutional Providers: NUBC Code: Code modifiers are not permitted.  
For Professional Providers: HCPCS Code:  
• Two character code modifier is optional. |
| *Allowed Amount        | Numeric - The amount per contract that the provider has agreed to accept from the payer. Not to exceed $999,999.99. |
| Effective Date         | Required date format is MM/DD/YYYY. |
| Expiration Date        | Required date format is MM/DD/YYYY. |
1. Open spreadsheet program. (i.e. Microsoft Excel, Apple Numbers, or any online spreadsheet program). A blank spreadsheet should appear.

2. Enter the Required Fields in the order listed above. Leave the first cell in the first column and row blank (A1 in the example above). If omitting an Optional Field (Code Qualifier, Code Modifier, Effective Date, or Expiration Date), leave blank cells as placeholders for these field positions. After entering the required information in Row 1, the spreadsheet should be formatted like the example below:

   Note: The blank cell under Column F represents the omission of a Code Modifier for the contract rate.

3. Enter each contract rate for payers on separate rows. After entering all contract rate data in the format above, Save your document.

   Select File > Save As. The Save As dialog box will appear.
Note: Save the file as a comma delimited file type (.csv) in the “Save as type” dropdown box to ensure the file is correctly uploaded.

The contract rate file should be formatted like the example below if opened in a plain text editor:

4. After saving the contract rate file to your local hard drive, proceed with the “To Import Contract Rates” instructions, starting with Step 4.
Module Five – Check Claims

Objectives
In this section you will learn about the following:

- Check a claim status
- Use the card swipe
- Claim Status Information
- Claim Financial Inquiry

Overview
Check Claims allows users to check the status of a previously submitted claim, regardless of whether the claim was submitted manually or electronically. This tool allows managing claim rejections, reimbursements, and online claim adjustments, which eliminates having to re-key information and generate duplicate forms.

Key Features
- Fast access to real time claim status information for multiple payers
- Individual and batch functionality for improve productivity
- Time-saving batch management features: Sort, Move, Copy, Delete
- Ability to track claims throughout the reimbursement cycle
- Verify that claims have been received by payers
- Quickly determine the status of claims
- Expedite follow up on rejected claims
- Select “Payer Enrollment” from the Home page to obtain the enrollment forms.

Check a Claim Status
Follow these steps to obtain a claim status:

1. Select Claims > Claim Status on the main menu.
2. Select a payer from the drop-down list. Note: The claims request screen varies depending on the payer.
3. Enter search criteria for the selected payer to locate the claim. The minimum required fields are preceded by a red asterisk.
4. To find a “Provider ID”, click the Select... button.
5. If the Requesting Provider is the same as the Service Provider, click the “Same as Requesting Provider” checkbox. This populates the Service Provider fields with Requesting Provider Info, as shown on the next illustration.

The following illustration shows a completed Check Claims form:
6. Click **Send to Payer** to process your query. The following illustration shows results of this inquiry.

7. Scroll down to view the complete claim status information.

8. Click **Save Response to Batch** to save the response to a new or existing batch.
The following window appears:

<table>
<thead>
<tr>
<th>MyBatch061388</th>
<th>Refresh List</th>
</tr>
</thead>
<tbody>
<tr>
<td>-- OR --</td>
<td>Save Transaction to a New batch:</td>
</tr>
<tr>
<td></td>
<td>Save</td>
</tr>
</tbody>
</table>

Do one of the following:

- To save the response to an existing batch, choose the batch from the drop-down list. Click **Refresh List** if your batch is not displayed in the list.
- To save the response to a new batch, enter the batch name. Click **Save**.

**Note:** The Save Response to Batch link appears only if batching is off.

9. When finished, click **Return to Request** to return to the Claims Inquiry window. Do not click the **Back** button on your browser since this may cause unpredictable results.

### Card Swipe

The card swipe feature allows users to retrieve patient information from swipeable insurance cards (only available for supported payers). The card swipe option automates the entry of a member ID or ID card number. The user is still responsible for entering all other provider and service information.

1. **Select Eligibility** from the main menu. [Should be Claims?]
2. Select a payer from the drop-down list in the **Step 1 area**.
3. In the **Step 2 area**, select the desired search.
4. Click the **Read Card** button, located next to the field which can accept the card swipe data (such as **Member ID** field).

**Note:** Only payers who support the card swipe feature will have this option on the payer’s screen.
A dialog box will appear instructing the user, “Please swipe card now.”

5. Swipe the member’s ID card.

### Claim Status Information

Office provides the following claims status information:

- Claim status
- Claim number
- Trace number
- Patient/Insured Data
- Provider Data
- Claim Amount
- Payment Amount

### Claim Financial Inquiry

The Claim Financial Inquiry (CFI) transaction allows users to receive a more detailed response when checking the status of a claim. The CFI transaction occurs after the Claim Status Notification has been returned by the regular check claim status transaction.
Note: The CFI transaction is only available for the payers who support the transaction.

1. Select **Claims > Claim Status** from the main menu.
2. In **Step 1**, select the payer name from the drop down menu.
3. Enter search criteria in the remaining fields on the form for **Step 2**.
4. When finished, click **Send to Payer**. After a few seconds, a Claim Status Notification displays with one or more claims matching your search criteria.
5. Locate the claim you wish to receive a CFI response for. If the payer supports the CFI transaction, there will be a “Financial Inquiry” link near the “Claim #.”

<table>
<thead>
<tr>
<th><strong>Claim Status Notification</strong></th>
<th><strong>Coventry Health Care Carelink</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Request:</strong> insured=TEST1 TEST1 MemberID=12345678901 DOE=12/12/1940 ProviderID=252916</td>
<td></td>
</tr>
<tr>
<td><strong>Payer Contact Info:</strong> Emdeon Trace Number:1999999999</td>
<td>Name : CUSTOMER SERVICE</td>
</tr>
<tr>
<td></td>
<td>Telephone : (800) 555-5555</td>
</tr>
<tr>
<td><strong>Patient:</strong> IMA PATIENT</td>
<td><strong>Service Provider:</strong> THE HOSPITAL</td>
</tr>
<tr>
<td>Member ID: 11111565555</td>
<td>Federal Taxpayer's ID: 444444444</td>
</tr>
<tr>
<td>DOB: 03/06/1945</td>
<td>Requesting Provider: THE HOSPITAL</td>
</tr>
<tr>
<td>Gender: Male</td>
<td>Electronic Transmitter ID: 444444444</td>
</tr>
<tr>
<td><strong>Claim #:</strong> 1111111111</td>
<td>[Save Responses to Batch]</td>
</tr>
<tr>
<td><strong>Status:</strong> Finalized/Payment: The claim/line has been paid</td>
<td></td>
</tr>
<tr>
<td>Payment reflects plan provisions. (Deactivate effective 1/1/2006)</td>
<td></td>
</tr>
<tr>
<td><strong>Status Information Effective Date:</strong> 01/08/2004</td>
<td></td>
</tr>
<tr>
<td><strong>Total Claim Charge Amount:</strong> $2,072.90</td>
<td></td>
</tr>
<tr>
<td><strong>Claim Payment Amount:</strong> $1,449.43</td>
<td></td>
</tr>
<tr>
<td><strong>Adjustment Date:</strong> 01/08/2004</td>
<td></td>
</tr>
<tr>
<td><strong>Payment Method:</strong> Check</td>
<td></td>
</tr>
<tr>
<td><strong>Check or EFT #:</strong> 61000095</td>
<td></td>
</tr>
<tr>
<td><strong>Billing Type:</strong> 131</td>
<td></td>
</tr>
<tr>
<td><strong>MRN:</strong> 00000083</td>
<td></td>
</tr>
<tr>
<td><strong>Claim Statement Period Start:</strong> 12/12/2003-12/12/2003</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Procedure</th>
<th>Svc Units</th>
<th>Date</th>
<th>As Of</th>
<th>Charge</th>
<th>Paid</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

6. Click the “Financial Inquiry” link located next to the “Claim #.” The Claim Financial Inquiry Response will be returned.
7. Click “Return to Previous” to return to the Claim Status Notification response.
Module Six – HCS Review Request

Objectives
In this section you will learn how to do the following:

- Submit a new referral
- Use the card swipe

Overview
The HCS Review Request service provides a way to refer patients online and to track the status of each referral. The HCS Review Request form is used to send all the pertinent patient information to the referred specialist.

Benefits
- Real time Referrals, Authorizations & Pre-certifications for multiple payers
- Individual and batch functionality for higher productivity
- Time-saving batch management features: Move, Copy, Delete
- Eliminate time consuming paper & phone-based processes
- Receive real time responses in seconds
- Comply with Managed Care requirements
- Eliminate claim rejections for non-covered services

Submit a New Referral
Follow these steps to submit a new referral:

1. Gather your identification information:
   - Patient's member number, and
   - Provider number for the professional to whom you are referring the patient.
   
   The New Referral window is shown in the following figure:

2. Select Service Review > New Review from the main menu.
3. Select a payer from the drop-down list. Note: The New Review screen and required fields vary depending on the payer.
4. On Step 2, select the type of referral.
5. On step 3, enter search criteria for the selected payer. The minimum required fields are preceded by a red asterisk.
6. When finished, click Send to Payer to send the referral. Once your request is processed, a referral response displays.

The following illustration shows a completed New Review form followed by a referral response.
Office - Real Time Transactions

Step 1 - Select payer

Step 2 - Select how you wish to search

Step 3 - Patient and Provider Information - * indicates required fields

Requesting Provider Info

Provider ID: 52367512
Provider Last/First Name: JOE GOODWELL
Provider Address: 77 HOLLY BLVD, SMALLVILLE, California 90214
Contact Name: Phone Number: Extension:
444-55-8820

Service Provider

Provider ID: 987654321
Provider Last/First Name: SUSAN HAPPY
Provider Address: 123 BIG LANE RD, LOS ANGELES, CA 99722

Step 3 - Service Information and Additional Request Details - * indicates required fields

Request for Review Status

Request: Name: JOHN GOODWELL Member ID: 123456789 DOB: 03/22/1958 Referral by: 622667512
Trace Number: 150110917

Patient: JOHN GOODWELL
Member ID: 123456789
DOB: 03/22/1950
Gender: M
Group #: 66

Submitter: JOE TERKIN
Submitter Type: Provider
Employer’s ID: 52367512

Service Providers

Name: HAPPY
Provider Type: Service Provider
Employer’s ID: 987654321
Address: 123 BIG LANE RD, LOS ANGELES, CA 99722

Services

Specialty Care Review

Certification Type: Initial
Service Type: Dental Care
Place of Service: Office

Certification Action: Pending
Reject Reason: Requires Medical Review

Procedure Information

ADA Procedure Code: ADAF
Units: 1

Notes

1. Proc #01 Tooth #01
7. Scroll down to view the complete referral request status information.

8. Make a note of the Trace Number since you will need it later to check the status of the referral.

   If you receive a “Duplicate Record” message, return to the HCS Review Request form and adjust the start date or the end date.

9. Click Save Response to Batch to save the response to a new or existing batch.

   The following window appears:

   ![Save Response to Batch Window]

   Note: The window displays the name of the last batch you used while batching was turned on. If you have never turned batching on, the pop-up displays either a default batch name (Default_<your initials>) or the name of the first batch on the Batch Manager list.

   Do one of the following:
   
   • To save the response to an existing batch, choose the batch from the drop-down list. Click Refresh List if your batch is not displayed in the list.
   
   • To save the response to a new batch, enter the batch name.
   
   Click Save.

   Note: The Save Response to Batch link appears only if batching is off.

10. When finished, click Return to Request to return to the HCS Review Request page.

    Do not click the Back button on your browser since this may cause unpredictable results.

**Card Swipe**

The card swipe feature allows users to retrieve patient information from swipeable insurance cards (only available for supported payers). The card swipe option automates the entry of a member ID or ID card number. The user is still responsible for entering all other provider and service information.

1. Select Eligibility from the main menu. [Should this be Service Review > New Review?]

2. Select a payer from the drop-down list in the Step 1 area.

3. In the Step 2 area, select the desired search.

4. Click the Read Card button, located next to the field which can accept the card swipe data (such as Member ID field).

   Note: Only payers who support the card swipe feature will have this option on the payer’s screen.
A dialog box will appear instructing the user to “Please swipe card now.”

5. Swipe the member’s ID card.
Module Seven – HCS Review Inquiry

Objectives
In this section you will learn about the following:

- Check a referral
- Use the card swipe
- Referral Status Information

Overview
The HCS Review Inquiry service provides referral status information with either a referral number or a combination of provider and member information.

Check a Referral
Follow these steps to obtain a referral status:

1. Select **Service Review > Check Status** from the main menu.
2. Select a payer from the drop-down list. **Note**: The Check Status screen and its required fields vary depending on the payer.
3. Enter search criteria to locate the referral. The referral number usually provides the fastest way to search for a referral.
4. To find a Provider ID, click the **Select...** button.
5. When finished, click **Send to Payer** to send the referral inquiry. Once your request is processed, a referral status displays.

The following illustration shows a completed HCS Review Inquiry form and a referral status.
6. Scroll down to view the complete referral status information.

7. Click Save Response to Batch to save the response to a new or existing batch. The following window appears:

    ![MyBatch061388](MyBatch061388)
    Refresh List

    -- OR --
    Save Transaction to a New batch:

    ![Save Close](Save Close)

*Note:* The window displays the name of the last batch you used while batching was turned on. If you have never turned batching on, the pop-up displays either a default batch name (Default_<your initials>) or the name of the first batch on the Batch Manager list.

Do one of the following:

- To save the response to an existing batch, choose the batch from the drop-down list. Click Refresh List if your batch is not displayed in the list.
- To save the response to a new batch, enter the batch name. Click Save.

*Note:* The Save Response to Batch link appears only if batching is off.
8. When finished, click **Return to Request** to return to the HCS Review Inquiry window. Do not click the **Back** button on your browser since this may cause unpredictable results.

**Card Swipe**

The card swipe feature allows users to retrieve patient information from swipeable insurance cards (only available for supported payers). The card swipe option automates the entry of a member ID or ID card number. The user is still responsible for entering all other provider and service information.

1. Select **Eligibility** from the main menu.
2. Select a payer from the drop-down list in the **Step 1 area**.
3. In the **Step 2 area**, select the desired search.
4. Click the **Read Card** button, located next to the field which can accept the card swipe data (such as **Member ID** field).

   **Note:** Only payers who support the card swipe feature will have this option on the payer’s screen.

   A dialog box will appear instructing the user to “Please swipe card now.”

5. Swipe the member’s ID card.

**Referral Status Information**

Office provides the following referral status information:

- Referral status
• Referral number
• Referred to provider
• Referred by provider
• Dates of service
• Services to be performed
• Number of visits authorized
• Comments
Module Eight - Batch Manager

Objectives
In this section you will learn how to do the following:

- Create a batch
- Add transactions to a batch
- Submit a batch
- Sort transactions
- Re-submit a batch
- Customize batch services
- View batch responses
- Search for batches and search within a batch
- Move, delete, or copy inquiries

Overview
Batch Manager allows users to create and store multiple transactions for one-time submission. A batch may contain multiple inquiries and provides an easier way to obtain information without repeatedly re-keying patient data. Users can create as many batches as needed as well as copy or move selected inquiries from one batch to another. Batch Manager is available for all real-time transactions: Check Eligibility, Check Claim, HCS Review Request and HCS Review Inquiry.

Benefits
- Allows users to resubmit transactions without having to re-enter data.
- Allows users to send large numbers of transactions at one time.
- Provides complete flexibility to users.
- Eliminates time consuming paper and phone-based processes.
- Complies with Managed Care requirements.
- Eliminates claim rejections for non-covered services.

Create a Batch
Follow these steps to create a batch:

1. Select the Batch Manager icon from the main menu.

The Manage Batches screen appears.

2. Enter a batch name in the field labeled “Create new batch named:” and click Create. The new batch is added to the list.
3. The next step is to add transactions to the batch.

**Add Transactions to a Batch**

Follow these steps to add transactions to a new or existing batch:

1. Select one of the transactions from the main menu: Eligibility, Service Review, or Claims.
2. Click the Turn On Batching button located in the upper left hand corner to activate batch mode.
3. Select the target batch name from the Batch drop-down list.
4. Complete the electronic form and click Send to Payer. Once a transaction is added to the batch (by clicking Send to Payer), a confirmation message displays in the upper left hand corner of the screen: “Inquiry submitted and added to the current batch”.

**Batch Manager Tip 1**

You can tell whether you are in batch mode if:

- The Active Batch name appears in the upper left hand corner of the screen.
- The yellow banner with the message: “This Inquiry and Response will be added to the Active Batch” appears below the Send to Payer button.

**Submit a Batch**

Follow these steps to submit a batch:

1. Select the Batch Manager icon from the main menu.

   ![Batch Manager Icon](https://via.placeholder.com/150)

   The Manage Batches screen appears.

2. Select the batch you wish to view from the list of batch names. Details from the selected batch will display in the Batch Inquiry screen, as shown on the following illustration.
3. To specify a service date, enter the appropriate date in the boxed field labeled “When sending inquiries, set service date as:” Otherwise, the default service date is today’s date.

4. Use the check boxes to select one or more inquiries or check the box Select all above to select all.

5. Click the Send button to submit the selected inquiries. A message appears at the top of the screen: “Inquiries Submitted - Results will be available from this screen when ready.”

Note: The Go To Batch drop-down on the Batch Inquiry page is only shown if batch mode is off.

**Batch Manager Tip 2**

You may also submit an entire batch at once by locating the desired batch in the list of batches on the Manage Batches screen and then selecting Send in the Action column.

**Tip:** You should try to keep the number of transactions in a batch under 2,000.

**Responses**

After a batch is submitted, responses come back and display as hyperlinks on the Batch Inquiry screen.
Sort Transactions
Clicking on any column header on the Batch Inquiry screen will cause the batch list table to be sorted based on the selected column. A yellow triangle is displayed in the column header to indicate which field is the current sort criteria. An upwards pointing triangle means the search is in ascending or alphabetical order. Clicking on a column which is already being used as the sort criteria will cause the sort order to reverse and the triangle to turn upside down. Depending on the batch it may be helpful to sort by Status, Member ID or Provider ID.

Re-submit a Batch
The service date for an entire batch can be changed at once allowing batches to be reused. This can be done from either screen (Manage Batches or Batch Inquiry) by entering the new date in the “set service date as:” box, prior to sending a batch or a set of transactions.

Customize Batch Services
Users can customize many of the features in Batch Manager through the Customize link. The Customize link invokes the Customize Batch Services screen, which allows the user to select what columns to display and to set other preferences.

Batch Mode Settings
The choice between Save and Submit and Save Only applies to requests that are added to batch in interactive mode. If Save Only is selected than the transaction is NOT sent to the payer when the Send button is clicked. Users must go to the Batch Manager screen, select the request and send it before the transaction is processed by the payer. The default setting is Save and Submit.

Group Settings
Group settings control whether or not you can see batches created by other users with whom you work. The setting controls your view, not the view of other users. This means that if you are in Personal Mode, a co-worker in group mode can still work with your batches. Group Mode is the default.
When **Group Mode** is selected, empty default batches are not displayed. Once all transactions are removed from another user's default batch, the batch no longer appears on the batch list (Manage Batches) page.

### Customize Batch Services

**Batch mode settings:**
- **Save and Submit.** Submit transaction to the payer at the same time request is saved.
- **Save Only.** Save transaction for later submission to the payer.

**Group settings:**
- **Personal Mode.** Show only the batches you have created.
- **Group Mode.** Show both your batches and those created by your coworkers.

#### Select columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Display</th>
<th>Export</th>
<th>Column</th>
<th>Display</th>
<th>Export</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inquiry</td>
<td>[x]</td>
<td>N/A</td>
<td>Service Provider ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transaction Type</td>
<td></td>
<td></td>
<td>Service Provider Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payor Name</td>
<td></td>
<td></td>
<td>Request #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Account Number</td>
<td></td>
<td></td>
<td>Trace #</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modified By</td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dates</td>
<td></td>
<td></td>
<td>Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Member ID</td>
<td></td>
<td></td>
<td>Charges</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Member Name</td>
<td></td>
<td></td>
<td>Request Status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requesting Provider ID</td>
<td></td>
<td></td>
<td>Status Messages</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requesting Provider Name</td>
<td></td>
<td></td>
<td>Response</td>
<td>[x]</td>
<td>N/A</td>
</tr>
<tr>
<td>Proc Codes</td>
<td></td>
<td></td>
<td>Plan Desc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diag Codes</td>
<td></td>
<td></td>
<td>Payment Notes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Select # of batch transactions per page:** 200

### Select Columns

The user can customize which columns should display in the batch list by checking on and off the column names listed in the “Select Columns” table. Placing a check mark in the **Display** column indicates that a column will be displayed. Placing a check mark in the **Export** column indicates that the selected value will be placed in the export file when exporting a request using the “Selected Columns” mode. (See “Export Inquiries” on page 87 of this guide).

When choosing which columns to display, keep in mind that using a large number of columns will cause the display to become so wide that horizontal scrolling will be needed to see the entire table. Including the **Status Messages** column can be helpful.

### Select # of Batch Transactions per Page

A large page size means more requests can be worked with simultaneously. Keep in
mind that a larger page size may also cause your computer to time-out if your Internet connection is slow.

Resubmit a Transaction

The setting for automatic resubmission on temporary errors controls whether Office will detect that a request failed for reasons other than bad data and try again after a few seconds. Occasionally a payer may have a problem or receives more traffic than it can handle, resulting in a temporary error. This setting should be Yes for most users. If you submit Authorizations in a batch, it is recommended to select No to prevent the creation of duplicate requests.

View Batch Responses

Follow these steps to view batch responses:

- Batches can be viewed by clicking on the batch name or by clicking View from the Action column to the right of the batch name, in the Manage Batches window.
- To view a response, click on the Date/Time hyperlink for the transaction in the Responses column (shown in the above illustration).
- User can scroll to the bottom to check the box “Select all above” transactions for Send, Delete, Import, Export, View or Print. If more than 10 transactions are displayed, these buttons will also display at the top of the screen.
- The Date/Time shown in the Responses column reflects the last date/time the inquiry was processed. Pending means that the payer has not yet responded to the inquiry. Select Refresh Results to update the status of a pending inquiry. You may need to refresh the screen several times when a full batch is submitted, as response times will vary.
- To view multiple responses, select 2 or more transactions by clicking the check box to the left of the transactions, and then click the hyperlink for the first selected transaction. All the responses will append to one another in the response screen.
When viewing real time responses from Batch Manager, a Select check box displays on the upper right hand corner of the response screen, as shown on the next illustration:

- If there are multiple responses, navigational links allow viewing the previous and next transactions.
- The Select box is a visual aid to help users keep track of every viewed transaction. If the user checks the Select box on the response screen, when the user returns to the Batch Inquiry screen, a checkbox will display on the Select column, indicating the item number of the recently viewed batch.

On the response screen, you can search for specific responses or conditions by using the Find feature of the browser. The text you are searching for will appear highlighted as shown on the next illustration.
Search for Batches

Users can search for batches from the main Batch Manager screen by entering data on the search field and clicking the Search Inquiries button. Batch Manager will search through the saved transactions on all batches within the same location. Only those batches with data matching the search criteria will be displayed.

- Any value or alpha-numeric character string found in a transaction request may be used as a search value. Typical search keywords are: Patient Name, Patient Member ID, Account #, Payer Name and Transaction Type.
- You may enter multiple keywords, separated by a space, to narrow down the search results. If multiple keywords are entered, they should be separated by a space as the illustration on the next page shows.

In this example, a search is done for all batches containing Eligibility transactions for Medicaid payers.

<table>
<thead>
<tr>
<th>Batch</th>
<th>Number of Inquiries</th>
<th>Owner</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>01_Nov_batch</td>
<td>5</td>
<td>Lisa Stevens</td>
<td>Send</td>
</tr>
<tr>
<td>Default_QW</td>
<td>1</td>
<td>QA Willy200</td>
<td>Send</td>
</tr>
<tr>
<td>Default_WG</td>
<td>3</td>
<td>Willy GA6</td>
<td>Send</td>
</tr>
</tbody>
</table>

- The order of keywords does not matter. “Eligibility Medicaid” will yield the same results as “Medicaid Eligibility.”
- If you enter multiple keywords, the results will only include inquiries that contain all the keywords. For instance, “Eligibility Medicaid New York” will return only transactions containing those three values.

Note: To return to the previous list click the Batch Manager icon on the main menu.

Search within a Batch

To search within a batch, select the batch by clicking on it. When the Batch Inquiry screen displays, enter data in the Search Text field to narrow down the number of transactions, as shown on the next illustration:
After clicking the Search button, only those transactions that match the data in the Search Text field will display, as shown on the next illustration.

The Back button (next to the Search button) may be used to remove the search filter and display all requests in the batch. Clicking the Search button also clears the search filter if no value is entered in the Search Text field.

**Move or Copy Inquiries**

Follow these steps to move and copy inquiries:

1. Select the batch you wish to copy or move inquiries from. The Batch Inquiry screen displays.
2. Select the inquiries you wish to copy or move by clicking the check boxes on the left hand column.
3. Select the name of the target batch from the appropriate drop-down list:
• Copy inquiries into batch... or
• Move inquiries into batch...
4. A confirmation message appears. Click OK to continue or click Cancel to stop the operation.

Delete Inquiries
Follow these steps to delete inquiries:
1. Select the batch from the drop-down list containing the inquiries you want to delete. The Batch Inquiry screen displays.
2. Select one or more inquiries by clicking the check boxes on the left hand column.
3. Click the Delete button. A Delete Confirmation window appears.
4. Click OK to continue or click Cancel to stop the operation.
Module Nine – Batch Import & Export

Objectives

In this section you will learn how to import and export files. [Needs work.]

Overview

The **Batch Manager Import** feature allows you to import files from your existing management system, eliminating data entry and enabling you to submit multiple transactions. The **Import** feature uploads patient data stored as a file on your computer and then imports that file into Office for batch eligibility, claim status and referrals.

Benefits

- Allows users to resubmit transactions without having to re-key search data.
- Allows users to send large numbers of transactions at one time.
- Increases reimbursements.
- Eliminates time consuming paper & phone-based processes.
- Eliminates claim rejections for non-covered services.

Requirements

- Practice Management System with the ability to create a flat file.
- Ability to map a file into the required format. Once a site has completed the initial process of creating and mapping a file from their Practice Management System (PMS) they can import it into Office.

Import a File

Follow these steps to import a file into Batch Manager:

1. Select the **Batch Manager icon** from the main menu. The Manage Batches screen appears.
2. Select an existing batch or create a new batch as the destination for your file. (See “Create a Batch” on page 75 of this guide).
3. Select the Import link. The Import Request screen appears.
4. For specific details on how to create an import file, click on the [which?] link in step 1.
5. In step 2, sample import lines can be downloaded for any or all payers. These show the minimum data elements required per request.
6. When you are ready, click **Proceed to Next Step**. The File Import screen appears.


7. The **Current batch** field defaults to the batch name selected. You may also select another batch or even create a new batch.

8. Click **Browse** to locate the import file on your network or PC.

9. Indicate how you wish to process the import file in Step 3 by selecting one of two options:
   - Save to batch
   - Test import file

10. Indicate how to convert patient records to patient requests in Step 4 by selecting one of two options:
    - Best match
    - All matches

11. When you are ready, click **Start Import**. The **Batch Import Status** screen appears.

12. **# Records imported** indicates the number of records that were successfully imported.

13. To continue, click one of the three buttons on the **Batch Import Status** screen:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Batch</td>
<td>Click this button to return to the <strong>Batch Inquiry</strong> window without submitting a batch.</td>
</tr>
<tr>
<td>Button</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Submit Batch</td>
<td>Clicking this button displays a confirmation screen asking if you want to submit the new inquiries in the batch. Click OK to submit the inquiries or click Cancel to stop the operation. If you click OK the inquiries are submitted and after a few seconds, the Batch Inquiry screen appears. Once the results are available they will appear on that same screen.</td>
</tr>
<tr>
<td>Close Window</td>
<td>Click this button to return to the Import Request screen without submitting a batch.</td>
</tr>
</tbody>
</table>

After clicking View or Submit, the user is returned to the Batch Inquiry screen where all imported transactions display. Responses will begin to appear one at a time.

**Batch Export**

The Batch Manager Export feature takes a group of inquiries and converts them to a text file that can be imported into a PMS or EMR system.

The export function can be initiated from either the Batch Manager or the Batch Inquiry page. Both export functions have the same behavior. In either case, the set of possible fields that may be exported is the same as the set of fields that appear on the Batch Inquiry screen. Users can customize which fields to export, by clicking the Customize link from either screen and using the check boxes to select the appropriate fields. By default, all fields except “Inquiry” and “Response” are selected. Batch export only supports X12 transactions.

**Export Inquiries**

Use the following procedure to export inquiries into a file:

1. Select the Batch Manager icon from the main menu. The Batch Manager screen appears.
2. Select the batch you wish to export or create a new batch.
3. From the Batch Manager screen click the Export link to export an entire batch, or from the Batch Inquiry screen click the Export button to export selected transactions in a batch. (The search and sort features can be helpful in selecting part of a batch, prior to choosing Export). The Batch Export Services screen appears.
4. Select one of two export settings.
   - The **X12 Full Response** mode provides 2 lines of text for each request in the file. The first is the X12 **request** string and the second is the X12 **response** string. This mode is useful if you plan to import the file created by Office into a system that can interpret X12.
   - The **Selected Columns** mode generates a comma delimited file with one row per request. The values exported are set by the user in the batch Customize screen (see “Select Columns” on page 79 of this guide).

5. Click the **Download** button. A Windows File **Download** screen appears.

6. Click the **Save** button on the File **Download** screen.

7. Choose the destination drive and folder, enter a file name and click **Save**. Be sure to make a note of the file name and the location to which the file is written.

   **Note:** As temporary files are created, care must be exercised to ensure that files generated by multiple users do not overwrite one another and also that temporary files are removed after the download has been completed or canceled.

**X12 Full Response**

If the user requests an X12 full export instead of a summary export (selected columns), then the file generated will contain the complete X12 response. For each transaction two lines are written to the file. The first line contains the request string and the second line contains the response string.
Summary Response

When a user chooses **Selected Columns** as the export setting the resulting text file contains one line for each selected transaction. Additionally, the first line of the file contains labels for every field or column header. The selected fields for export are separated from one another by semicolons. The text displayed in the **Batch Inquiry** screen is included in the export file. The following illustrates a sample export file.

<table>
<thead>
<tr>
<th>Txn Type;Payer Name;Patient Acct #;Dates;Member ID;Patient Name;Requesting Provider ID;Requesting Provider Name;Service Provider ID;Service Provider Name;Request #;Trace #;Services;Charges;Status;Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eligibility;AETNA;;Service: 06/24/2002-06/24/2002*Effective: 10/01/1994;1100008455;SWAY,PENNY;5762398;COLE VISION CORP;;;189050434;Health Benefit Plan Coverage;;Active Coverage;</td>
</tr>
<tr>
<td>HCS Review Inquiry;AETNA;;Certified: 07/12/2001;8000060000008185;BAIRD,LEAH;5244015;PHYSICIAN,PCP;;;111657057;CPT-4:92568<em>CPT-4:92568</em>CPT-4:92568*CPT-4:92568;;</td>
</tr>
<tr>
<td>HCS Review Request;AETNA;;Admit: 04/08/2002<em>Certified: 04/08/2002-04/09/2002;QXKPx010;WARD,MARY L;4257479;Black,Keith;6540820;St. Paul Medical Center;M451274700000;393309812;CPT-4:63042</em>CPT-4:22630<em>CPT-4:20670</em>CPT-4:22852*CPT-4:20670;;Modified;</td>
</tr>
</tbody>
</table>

When multiple values are displayed in a single cell in the batch list, these values appear separated by an asterisk (*) in a single export field. For example, an HCS Review Request may have multiple CPT codes on a single cell separated by asterisks.

Dates are another case where multiple portions of the response may appear together in a single field and separated by an asterisk (*). For instance, the date field for a particular referral might look like: “Service 0401200304052003*Admit 04012003.” This example indicates a date range for service date of 04/01/2003-04/05/2003 and a specific admission date of 04/01/2003.
Module Ten – Find Providers

Objectives
In this section you will learn how to do the following:

- Find a provider
- Duplicate provider records

Overview
This function allows users to find information on providers and to maintain lists of provider favorites. Information stored in Favorite lists is used to populate the requesting and service provider fields on real time transactions.

Find Providers may be launched 1) from the main menu 2) from the Find Provider button in “Manage Favorite Lists” and 3) from any of the Provider Favorites Lists that display when the Edit or Select button, next to Provider ID, is clicked on a transaction screen (shown below).

Note: Only Administrative users can add providers to requesting provider favorites.

Find a Provider
Follow these steps to find a Provider:

1. On the Find Providers screen, select a payer from the drop-down list.
2. Enter search criteria to find a provider. The amount of data required to search for a provider varies depending on the payer. Some payers support partial text searches on the Name field. For other payers, additional fields such as Provider ID, and Zip Code may be required.
3. Click Send to Payer. If your search is successful, a list of providers appears along with their practice information. The results content and layout will vary based on the selected payer, as shown in figures 1 and 2 below.

Note: The links and buttons for adding data to Requesting Provider favorites are only visible to Admin users.
### Provider Search Result for Coventry Health Care Carelink

**Records: 1 To 2, Total: 2**

<table>
<thead>
<tr>
<th>Provider</th>
<th>Effective Date</th>
<th>Clinic</th>
</tr>
</thead>
<tbody>
<tr>
<td>BEN CASEY</td>
<td>04/01/2002</td>
<td>ABC HOME HEALTH 222 BUTLER ST SHALER PLAZA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PITTSBURGH PA 15223-311 (412) 566-1200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group Practice # 204511</td>
</tr>
<tr>
<td>MARY K CASEY</td>
<td>11/24/2004</td>
<td>PHYSICAL REHAB CENTER 600 WALNUT STREET</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MCC KEEPSPORT PA 15132 (412) 123-4567</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Group Practice # 38256</td>
</tr>
</tbody>
</table>

**Records: 1 To 2, Total: 2**

- **Add to Requesting Provider List**
- **Add to Service Provider List**
- **Return to Request**

**Figure 1**

- If the results of your search appear as shown in Figure 1, select the provider(s) you want to add to a list of favorites, by checking the appropriate check boxes, and then click one of the two **Add** buttons.

- To return to the providers search screen without adding to favorites click **Return to Request**. Do not click the **Back** button on your browser since this may cause unpredictable results.

### Provider Search Results

**Request: Provider Id=32102167 Org/Last Name=CRANE**

- **Emden Trace Number**: 167378650

**Provider: CRANE, DAVID A (437110135)**

- **Location**: (009)
- **Add to Requesting Provider Favorites**
- **Add to Service Provider Favorites**
- **Address**: Contact Info
- **Telephone**: (814) 841-0005

**Provider: CRANE, FRASIER (310733772)**

- **Location**: (002)
- **Add to Requesting Provider Favorites**
- **Add to Service Provider Favorites**
- **Address**: Contact Info
- **Telephone**: (814) 252-0917

**Figure 2**

- If the results of your search appear as shown in Figure 2, you have a choice depending on how many providers you select:
  - To add a **single** provider to a list of favorites, click one of the “Add” hyperlinks under the **Location** or **Group** of the desired Provider.
  - To add **multiple** providers to a list of favorites, select the check boxes.
next to the Location or Group of the desired providers, and then click one of the “Add” buttons.

**Note:** For each provider, there may be one or more Locations. There may also be one or more Groups. You may select either a group or a location, but not both. Selecting a group or location is just a way to specify which address to use for a provider.

**Additional Information**

- Selecting a provider and clicking one of the Add buttons (or links) copies all the demographic data available to a favorites list (or transaction) not just the provider name and ID.
- On occasion, a Find Provider search will return a message indicating that there are too many results that cannot be displayed due to size restrictions. If this happens, add additional search criteria and try again.

**Duplicate Provider Records**

If a provider is a duplicate of another provider record, the user is prompted to either update or create a duplicate record as shown on the next illustration:

If this happens, select one of the radio buttons to indicate whether you want to add a new provider or update the existing provider and then click **Submit**.
Module Eleven – Payment

Objectives
In this section you will learn how to do the following:

· Use the Payment Manager
· Submit credit card payments
· Use the Credit Card Report link

Overview

The Payment tab appears on the main menu for those users who are enrolled for, or eligible to enroll for, one of the following services:

· Payment Manager
· Credit Card Processing

Note: Reference materials regarding the payment services are available by selecting More (see page 103).

Payment Manager
The Payment Manager link [Where is this link?] provides access to a Login page for the Payment Manager application. This is a web-based solution that allows payers to deliver ERAs (electronic remittance advices), EOBs and payments to providers electronically. Payment Manager allows providers to access electronic payment information at any time, printing only those documents that require hard copies.

This page also provides links to the Emdeon Business Services web site, information on HIPAA, access to Payer Lists, important messages for claims submitters, and links to Payment Manager tutorials. (These tutorials may also be accessed by selecting the More sub-menu item under Payment).

Note: You should have a separate User ID and password for this service. If you have not been issued credentials but would like access to the online remittance management service, please contact your sales representative for enrollment instructions.

Charge Credit Card
This screen allows users to enter and submit credit card payments from Office. After entering payment and credit card information and selecting the Submit Payment button, the form is then sent to a virtual merchant that accepts and processes the information. As a security measure, the Credit Card Number and Security Code are converted to a string of asterisks prior to submitting the transaction.
The Merchant Connect Login link, located on the upper right corner of the screen, allows users to manage their virtual merchant account, access recent statements and detailed information on payment activity and obtain customer support.

The Submit Payment screen displays when a user selects Charge Credit Card from the Payment menu. (This screen will display only after credit card enrollment is complete.)

Manually Submit a Credit Card Payment

1. Enter required and optional fields on the data entry form in the Step 1 area. The table below describes the valid format for each field. Required fields are marked with a red asterisk (*):
### Field | Explanation
--- | ---
*Charge Amount | Alphanumeric - The total amount to be charged to the credit card.

Eleven (11) characters (can include decimal, dollar sign, or commas). Not to exceed $999,999.99.

| First Name | First name of the credit card holder as it appears on the credit card.
| Last Name | Last name of the credit card holder as it appears on the credit card.

| Patient Zip Code | The zip code of the credit card holder
| Customer ID/Invoice | Customer ID or Invoice # assigned by the provider.

| *Card Type | The type of credit card used. Drop-down selections include American Express, MasterCard, Visa, Discover and Other.
| *Card Number | Numeric - The card number as it appears on the front of the card. Sixteen (16) characters.
| *Expiration Date | Month and date of credit card expiration.

| *Code | Numeric - Required for American Express, MasterCard, and Discover transactions. Three (3) to four (4) digit security code printed on the back of the credit card.

2. Select the “Credit Card Charge” or “Refund” radio button below the credit card information section.

**Note:** The “Credit Card Charge” button will be selected by default.

3. Select the Submit Payment button. All controls on the form are disabled and a "Processing payment. Please wait..." message is displayed.

4. If the data entered is accepted, the data on the form is submitted and a message displays at the bottom of the same screen with a reply of “Transaction approved” in green.
5. If the transaction is denied, a message of “Transaction denied” will appear in red at the bottom of the same screen. You can correct the invalid entries and resubmit the transaction.

6. If there is an error with the information submitted, a message of “Transaction error” will appear in red at the bottom of the same screen. You can correct the invalid entries and resubmit the transaction.

7. If the transaction is accepted, all controls are disabled except Reset and Print Receipt.
   Select Reset to clear all standard form fields, and submit additional transactions.

Credit Card Swipe
Office supports credit card swipe, allowing users to expedite credit card transactions.
Setup and System Requirements

In addition to the minimum requirements for operating system, browser, and internet connection as defined in the System Requirements for Emdeon Office, the credit card swipe functionality also requires one of the following:

Secure Magtek USB card reader
Unsecure Magtek USB card reader
Any unsecure reader that behaves like a keyboard wedge

The difference between secure and unsecure card readers is data encryption. Secure card readers read data and then encrypt it before passing this information to the receiving application on your computer using ActiveX controls. Encryption lessens the risks associated while data is transferred. Unsecure card readers do not encrypt data.

Internet Explorer

Ensure that your web browser is configured to run ActiveX controls and download ActiveX controls when prompted.

1. Select Tools > Internet Options from the menu bar at the top of the IE screen. The Internet Options screen appears.

![Internet Options](image)

2. Select the Security tab.

3. Select the Custom Level... button.
4. Under ActiveX controls and plug-ins, make sure the following are set:
   Download unsigned ActiveX controls should be set to Prompt
   Run ActiveX controls and plug-ins should be set to Enable

5. Select OK to save changes.
6. Select “Charge Credit Card” under the Payment tab on the main menu.
7. Select the “Swipe Card” button. Users will be prompted to install the ActiveX Control.
8. Click “Install” and follow the on-screen instructions.
9. After installing, swipe credit card to ensure full functionality.

Firefox
Firefox requires a plugin to use the Card Swipe functionality. Users will be prompted to install the plugin the first time they select the “Swipe Card” button.

1. Select “Charge Credit Card” under the Payment tab on the main menu.
2. Select the “Swipe Card” button.
3. Select “Install Missing Plugins” when prompted.

Note: If Firefox users already have this plugin downloaded for some other application, they will not be required to install it again. For these users, the Card Swipe should work the first time.

4. Select the “Manual Install” button next to “Unknown Plugin.” (This plugin is the MeadCo Neptune plugin required for using Credit Card Swipe).
5. Select “Save File.”
6. Select the directory you wish to save the file to, and select “Save.”
7. From the Downloads menu, select Open to begin the installation.

8. Select OK when asked if you want to “Open Executable File?”

9. Follow on-screen instructions to complete installation.

10. Once finished, swipe credit card to ensure full functionality.

After installing the plugin, users will be able to access the “Swipe Card” screen. On this screen, users will see an “Internet Options” button. They should select this button and follow these instructions to enable ActiveX Controls:

1. Select the **Security** tab.
2. Select the **Custom Level**... button.
3. Under ActiveX controls and plug-ins, make sure the following are set:
   - Download unsigned ActiveX controls should be set to Prompt.
   - Run ActiveX controls and plug-ins should be set to Enable.

4. Select OK to save changes.

5. Upon first use of credit card swipe, users will be prompted to install the ActiveX Control.

6. Click “Install” and follow the on-screen instructions.

**Use Credit Card Swipe**

Ensure that all system requirements have been met before running credit card transactions using card swipe.

1. Select “Charge Credit Card” under the Payment tab on the main menu. The Submit Payment screen will appear.

2. Select the “Swipe Card” button.
3. A screen instructing users to “Please Perform Unsecure Credit Card Swipe Now” appears until the credit card has been swiped.

**Note:** Unsecure Reader is the default for Credit Card Swipe. The screen that appears will give users the ability to switch to a Secure Reader if they have a Secure Card Reader installed. If configured for a Secure Reader, users will also have the ability to “Switch to Unsecure Reader.”

4. After the credit card has been swiped, the screen will disappear, and the credit card fields in the Submit Payment screen will be populated.

5. Enter the following information manually—only those marked with a red asterisk (*) are required:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Charge Amount</strong></td>
<td>Alphanumeric - The total amount to be charged to the credit card. Eleven (11) characters (can include decimal, a dollar sign, or commas). Not to exceed $999,999.99.</td>
</tr>
<tr>
<td><strong>Patient Zip Code</strong></td>
<td>The zip code of the credit card holder.</td>
</tr>
<tr>
<td>Customer ID/Invoice #</td>
<td>Customer ID or Invoice # assigned by the provider.</td>
</tr>
<tr>
<td><strong>Code</strong></td>
<td>Numeric - Required for American Express, MasterCard, and Discover transactions. Three (3) to four (4) digit security code printed on the back of the credit card.</td>
</tr>
</tbody>
</table>

6. Select Credit Card Charge or Refund depending on the transaction type.

7. Select “Submit Payment” button to process the transaction.

**Credit Card Report**

The Credit Card Report link, like the Merchant Connect Login link, allows users to manage their virtual merchant account, access recent statements and detailed information on payment activity and obtain customer support.

**Note:** Users will be provided a login at the time they sign up for Credit Card processing service. If a user forgets the password, follow MerchantConnect’s guidelines for retrieving a forgotten password.
More

From this page you can do the following:

- Add remit providers or plans
- Access tutorials on Payment Manager

The following table describes in detail each link on the Additional Resources for Payment service.

<table>
<thead>
<tr>
<th>Link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutorial for Payment Manager</td>
<td>Provides access to Search, View &amp; Print Payment Manager Tutorial.</td>
</tr>
<tr>
<td>Add Remit Providers or Plans</td>
<td>This online form allows users to add providers or plans for payers, so providers can enroll in ERA remittance through Office. The online form generates an email to the Emdeon Office enrollment team who will complete the setup process.</td>
</tr>
<tr>
<td>Tutorial for Payment Manager With Posting</td>
<td>Provides access to the Standard Payment Manager Tutorial.</td>
</tr>
</tbody>
</table>